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1-2 Background of Conceptual Engineering 
1.1  Background of Conceptual 
Engineering Suite

Conceptual analysis methods are based on the application of simplified 
models of process plants coupled with powerful optimization 
algorithms.

For the successful application of these methods, a major requisite is the 
realization by the user that these conceptual models have been 
developed to capture the essence of the system, elements and major 
interactions. Adding details to the system during the conceptual 
analysis stage results in unnecessary complications. Fundamental 
engineering principles are often hidden behind a vast number of details 
in a process simulation environment, a typical example of this is found 
in the separation of multi-component azeotropic mixtures in distillation 
columns.

A process simulation user may not be aware of the thermodynamic 
limits imposed by azeotropes and following the traditional trial and 
error approach will result in many engineering hours wasted before this 
fundamental behaviour is identified.

The Lifecycle Vision of plant modelling proposes that a rigorous 
simulation model of a facility is a highly valuable asset for the owner and 
not simply a design and debottlenecking tool for process engineers. A 
detailed simulation model of the operating asset as-is (as opposed to as-
built) becomes a central repository of knowledge that can be accessed 
by the various agents involved in decision making.

For new facilities, the Lifecycle begins at the conceptual design stage 
where a limited amount of information is available and major design 
decisions must be made.
1-2



Introduction 1-3
To stress the difference between traditional process simulation and 
conceptual analysis, consider the following comparison of inputs and 
outputs for the application of these technologies:

It has been well documented that at the early stages of a project, and 
even more so for retrofitting cases, the decisions about the structure of 
the process will have a disproportionate impact on the final economics 
of the plant. In spite of all the evidence supporting this fact, it is 
common practice to make decisions regarding structure based on 
historical data only and not enough resources are applied at identifying 
the optimal process configuration.

Conceptual Engineering Suite is a set of software tools that have been 
designed to give engineers access to the latest methods for evaluating 
process configurations. The product includes the ability to screen and 
scope alternative process configurations in a number of areas such as 
azeotropic distillation, complex distillation arrangements (e.g. Divided 
Wall Columns), and energy recovery systems.

The task of finding a flowsheet that achieves the transformation of raw 
materials into desired products in an economic fashion is a complex 
one. It has been stated that for a typical process there may be up to 10,000 
different feasible flowsheets. The problem is then to identify the best 
structures without spending prohibitive amounts of resources in the 
process.

Process Simulation Conceptual Analysis

Inputs Feed conditions (T,P), composition and 
flow rates are known.

Feed conditions (T,P), composition and 
flow rates are known. 

Some inputs will have to be assumed 
since at the early stages of process 
development conditions may not be well 
defined.

Process 
configuration

Well defined. 

User needs to know the connectivity 
between unit operations and details of 
units such as number of stages in a 
distillation column, etc.

Unknown. 

The process structure is included in the 
decision variables of the problem.

Outputs Unknown. 

It is expected that a proper simulation 
model will produce with high fidelity the 
outputs for the units for a given set of 
inputs. Objective is to have a unique 
solution to the system.

Known. 

In a conceptual analysis framework the 
desired outputs from the process are 
identified in terms of product purities, flow 
rates and economic constraints.
1-3



1-4 Background of Conceptual Engineering 
The main challenges that the engineer faces when applying conceptual 
analysis methods are discuss in the following sections.

1.1.1  Multiple solutions 
(combinatorial problem)

For any given design/revamp project there will always be multiple 
solutions regarding process structure, even when a decision on the 
technologies to use has been reached (e.g., distillation vs. absorption). 
The number of alternatives tends to be so large that there is no realistic 
hope of analyzing them all even at the simplest level. A classic example 
of this is found in separation systems for multi-component mixtures as 
illustrated in the figure below:

For the separation of a ternary mixture using distillation columns, we 
have only 2 solutions available: the direct and the indirect sequence.

As we increase the number of components in the feed to the separation 
system we witness a combinatorial explosion. For the example above, a 
mixture containing five components results in fourteen alternative 
flowsheets, and a feed with eight components results in four hundred 
and twenty nine possible configurations.

 Figure 1.1
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The figure below illustrates the increase in number of possible designs 
as the number of components increases:

 Figure 1.2
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1-6 Background of Conceptual Engineering 
1.1.2  Insights
Before attempting to model and perform a rigorous simulation of a 
specific process or unit operation, engineers have access to 
fundamental physical principles that will identify early on constraints 
on the process, thus making the whole engineering lifecycle orders or 
magnitude more efficient. 

Consider the feasibility of a distillation column. For example, a simple 
case of a binary separation of an equimolar mixture of water and 
ethanol where process/market specifications require a purity of 99% 
Ethanol.

A quick analysis of the vapour-liquid equilibrium behaviour of this 
mixture reveals the presence of the well-known binary azeotrope 
between these components that immediately indicates that the 
proposed separation is physically impossible.

 Figure 1.3
1-6



Introduction 1-7
The key point in the above example is that there is no need for a rigorous 
simulation, tray-by-tray calculation, to figure out the limitations. This is 
Conceptual Analysis.

1.1.3  Cost Analysis
The capital and operating costs of the equipment in the plant varies 
greatly depending on the design. It is one of the engineer’s main 
objectives to find a design that is efficient in cost. 

Unfortunately, a detailed cost analysis of a number of process 
alternatives is not usually undertaken by engineers. The reasons are: 

• The expense of making detailed analysis of a number of 
alternatives.

• Unreliable operational cost data for different processes.
• The pressure of restricted time.
• The preferences of the designer who has experience with a 

particular sequence of processes, etc. 

Conceptual Engineering Suite provides a framework to identify cost 
efficient alternatives with limited amount of information.

 Figure 1.4
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1-8 Lifecycle Solution
1.2  Lifecycle Solution
Conceptual Engineering Suite fits into our LifeCycle Solution framework 
as illustrated in the figure below.

1.2.1  Conceptual Analysis
At the beginning of a project, the engineers has little information 
available mainly related to the objectives of the process, for example the 
market requirements for purity and volume, environmental restrictions, 
availability of raw materials, etc.

At this stage of the project the engineers want to:

• Screen and scope all of the process options without going into 
the minute details.

• Compare process options and economic performance quickly.
• Understand dominant trade offs.
• Identify a few promising candidates from several options for 

detailed study.

 Figure 1.5
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Conceptual Engineering Suite technologies allows the user to screen all 
design options using conceptual models coupled with powerful 
optimization algorithms and provides a generic and flexible framework 
to evaluate the effect of changing operating parameters and economic 
conditions.

1.2.2  Design
The results from the Conceptual Analysis stage need further validation 
with more detailed models. In the design stage the promising options 
and optimal operating parameters are seamlessly transferred to a steady 
state simulation environment. All the unit operation connectivity and 
operating parameters are initialized automatically. This not only 
eliminates the cumbersome step of manually inputting data from one 
stage to the next (from one tool to the next) but also assists greatly in 
converging complex flow schemes.

1.2.3  Analysis
Further examination of short-listed candidates is now done at the 
analysis stage. The dynamic behaviour of the flowsheet is now easily 
performed by setting up control loops and equipment details on top of 
the steady state simulation model.

Conceptual Engineering Suite is based on fundamental engineering 
principles. Conceptual Engineering Suite enables the creative 
engineering process. Conceptual Engineering Suite captures the 
essence of the system – no distractions with unnecessary details. 
Conceptual Engineering Suite – the potential for a step change in raw 
materials, capital and energy efficiency on your desktop.
1-9



Interface 2-1
2  Interface
2-1

2.1  Structure Terminology ....................................................................2

2.2  Desktop Terminology ......................................................................3

2.2.1  Menu Bar..................................................................................4
2.2.2  Toolbar......................................................................................5

2.3  View Terminology ............................................................................6

2.3.1  Active Location .........................................................................7
2.3.2  Views Functionality...................................................................8
2.3.3  Minimized Views.......................................................................8
2.3.4  Modal vs. Non-Modal Views.....................................................9
2.3.5  Project View ...........................................................................10

2.4  Interface Terminology ...................................................................13

2.4.1  Cells & Fields .........................................................................15

2.5  Manoeuvring Through the Interface ............................................16

2.5.1  Hot Keys - ALT Key.................................................................16
2.5.2  Moving Through a View..........................................................19
2.5.3  Entering Data .........................................................................20
2.5.4  Closing Views.........................................................................23

2.6  Trace Window.................................................................................24

2.6.1  Opening and Sizing the Window ............................................24
2.6.2  Available Information ..............................................................24
2.6.3  Object Inspect Menu ..............................................................25



2-2 Structure Terminology
2.1  Structure Terminology
Before beginning to explain how to use the interface, some of the 
terminology that are used in this manual will be defined. Every file 
includes certain structural elements:

Structure Terminology Definition

Fluid Package The fluid package includes the property package, components (library or hypothetical), 
binary coefficients, and flash control used for flowsheet calculations. Fluid packages can 
be imported and exported.

Manager All Managers can be thought of as repositories for the operations they manage. 
• Fluid Package Manager. Provides a single location to create or access fluid 

packages.
• Stream Manager. Provides a single location to create or access streams.
• Separation Manager. Provides a single location to create, delete or edit a suite of 

Separation operations including: Simple Column, Complex Column, and Three 
Product Systems (TPS). Available only in DISTIL.

• Azeotropic Separation Manager. Provides a single location to create, delete or 
edit a suite of Azeotropic Separation operations including: Azeotropes Analysis, 
Column Design, Azeotropic Column Sequencing (ACS), Distillation Region 
Diagram (DRD), Residue Curve Maps (RCM), and Split Generator. Available only 
in DISTIL.

• Thermodynamic Workbench Manager. Provides a single location to create, 
delete, or edit the following operations: Fluid Phase Regression, Phase 
Equilibrium, Property Table, and Pure Component Regression. Available only in 
COMThermo Workbench and DISTIL.

• Heat Integration Manager. Provides a single location to create, delete or edit the 
following operations: Heat Integration Projects, Heat Integration Projects in Retrofit 
mode, and Heat Integration Cases.  Available only in HX-Net.

Project The Azeotropic Column Sequencing project is an individual operation. This operation 
allows you to calculate azeotropes in the system, determine the structure of the 
distillation region, and assess the feasibility of separating multi-component mixtures. 
Available only in DISTIL. 

A Heat Integration Project is an individual operation that performs a heat integration 
analysis. A Heat Integration Project is also referred to as a HI project.  Available only in 
HX-Net.

Each project provides access to two lower levels: Scenario and Design.

Heat Integration Case / HI 
Case

A Heat Integration Case is an individual operation that performs a heat integration 
analysis. A Heat Integration Case is also referred to as a HI case. Each HI case only 
contains one design. Available only in HX-Net.

Retrofit Mode The Retrofit Mode can be entered through any HI project, and allows retrofit analysis. 
The HI project in retrofit mode is also referred to as a Retrofit project. Available only in 
HX-Net.

Case / File A case/file is a collection of fluid packages, data, and operations. The case/file can be 
saved to disk for future reference. Each case/file name has the extension *.hcd when it is 
saved.

Session Encompasses the work you are doing while the software is running. You can have only 
one session open at a time.
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2.2  Desktop Terminology
The figure below displays the basic components of the DISTIL desktop:

The main features of the desktop are:

 Figure 2.1

Desktop Features Definition

Title Bar Indicates the case currently loaded.

Menu Bar Provides access to common commands through a drop-
down menu system.

Toolbar Contains various icons each of which invokes a specific 
command when clicked.

Status Bar When the mouse pointer is placed over an icon in the 
toolbar, manager, or operation view, a brief description of 
its function is displayed in the status bar. Information is 
also displayed in the status bar if the mouse pointer is 
placed over cells in tables. The status bar also displays 
solver status information.

The desktop displayed in the 
figure has been resized to fit 
this page.

Title bar

Status Bar

Menu bar

Toolbar

Trace 
Window

Double 
Border

Calculation/Responsiveness icon

Minimize, Maximize, and Close icons
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2-4 Desktop Terminology
Some additional features about the desktop:

• There is a double border around the desktop. Any view which has a 
double border (including the desktop) can be sized by placing the 
mouse pointer over the edge or corner, when the mouse pointer 
becomes a double-headed arrow click, hold, and dragging the 
border in the direction you want to size, horizontally or vertically.

• The desktop has the special Minimize and Maximize icons 
reserved for application windows. These icons minimize the 
application to a minimized view or maximize the application to full 
screen depending on which icon was clicked.

• The desktop itself has both a vertical and horizontal scroll bars. 
These automatically appear when parts of the views within the 
desktop are situated outside the desktop border.

2.2.1  Menu Bar
Most of the functions in the program have hot keys or buttons 
associated with them, which provide quick access to their capabilities. 
Some of these functions can also be accessed through the menu bar. The 
list of menu commands or function groups, which is displayed at the top 
of the desktop, operates as a pull down menu system. By selecting one of 
the menus in the menu bar, a menu of associated commands opens.

In addition to the functions already described, the menu bar also 
provides access to a number of functions that can only be accessed 
through this route. Included in the functions that can only be accessed 
via the menu bar are setting Session Preferences (units, Datasheet 
formats, etc.) and arranging the view and desktop display.

You can access the menu bar commands in three ways: 

• Select the desired menu bar item by clicking on the item, which will 
automatically open the associated menu.

• Press the ALT key in combination with the underlined letter in the 
menu bar title. For example, ALT T will open the Tools menu.

Trace Window Located at the bottom of the desktop view, the Trace 
Window is closed by default. Its main function is to display 
errors or warnings. For more information, refer to Section 
2.6 - Trace Window.

Calculation/
Responsiveness Icon

Allows you to control how much time is spent updating 
views versus how must time is spent performing 
calculations.

Desktop Features Definition

Calculation/Responsiveness 
icon

Minimize icon

Maximize icon

Session Preferences can be 
accessed through the menu 
bar only.
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• Press the ALT key by itself to move the active location to the File 
menu in the menu bar. Once the menu bar becomes the active 
location in the program, you can manoeuvre through it using the 
keyboard. The up and down arrows move through the menu 
associated with a specific item, while the left and right arrows move 
you to the next menu bar item, automatically opening the associated 
menu.

If you want to switch focus from the menu bar without making a 
selection, press the ESC key or the ALT key.

2.2.2  Toolbar
The toolbar provides immediate access to the most common 
commands, which are also available in the menu bar.

The table below list all the possible icons available in the toolbar for 
DISTIL and HX-Net:

 Figure 2.2

Name Icon Function

New Case Allows you to create a new case.

Open Case Allows you to locate and open an existing case/
file.

Save Case Allows you to save the active case.

Fluid Package Manager Allows you to open the Fluid Package Manager 
view.

Available only in COMThermo Workbench and 
DISTIL.

Stream Manager Allows you to open the Stream Manager view.

Available only in COMThermo Workbench and 
DISTIL.

Thermodynamic 
Workbench Manager

Allows you to open the Thermodynamic 
Workbench Manager view.

Available only in COMThermo Workbench and 
DISTIL.

Figure 2.2 displays the HX-
Net toolbar. 
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2-6 View Terminology
2.3  View Terminology
Views are used extensively in this software in order to allow access to all 
information associated with an item in a single location.

Several time saving features have been built into a view.

• You will automatically return to the tab that was active the last time 
the view was open. Each view remembers its settings 
independently.

• Moving from one tab to the next is accomplished by clicking on the 
desired tab.

Some definitions and terminology will be presented in order to 
adequately explain the functionality and capabilities of the program. 

Separation Technology 
Manager

Allows you to open the Separation Manager 
view.

Available only in DISTIL.

Azeotropic Separation 
Technology Manager

Allows you to open the Azeotropic Separation 
Manager view.

Available only in DISTIL.

Heat Integration Manager Allows you to open the Heat Integration 
Manager view.

Available only in HX-Net.

 Figure 2.3

Name Icon Function

List of pages 
in the tab.

Active Tab

Active Page

Tabs

View

Refer to Section 2.4 - 
Interface Terminology for 
more information.
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Tabs
Each view is made up of tabs, which are displayed near the bottom of 
the view. The tabs contain relevant information and applications 
concerning the view. The Setup tab in Figure 2.3 appears to be on top of 
the other tabs, indicating this is the active tab.

Pages
Each tab can be divided into pages. The pages in a tab are displayed in a 
list located on the left side of the tab. The pages provide access to 
detailed information regarding the selected tab. The Fluid Package page 
in Figure 2.3 appears in bold letters, signifying that this is the active 
page. 

2.3.1  Active Location
The current active location is always indicated by highlight, bold 
lettering, thick border, etc. Typically the active location occurs on two 
levels: view level and objects-within-view level. 

• At the view level, the Title bar of the active view will appear in a 
different colour than the other opened, but inactive views. The active 
view will also be placed on top of the other inactive views.

• At the objects-within-view level, the active object is indicated by 
highlight, bold lettering, dashed frame, or a thick border. A view has 
only one active location, however if a view has tabs and pages, the 
active tab and active page are indicated by bold lettering. The active 
tab and page are not considered to be the current active location of 
the view. 
For example in Figure 2.3, the active tab and page are indicated 
with bold lettering, and the current active location is the cell in the 
Selected column. The active location is indicated with a thick border 
around the cell.

For an object to be active in the view, the view also have to be active.

The last active cell that was 
used or selected, also 
appears in a different colour 
than the other cells of the 
matrix/table. Each matrix/table 
has its own active cell.
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2-8 View Terminology
2.3.2  Views Functionality
The program views have the same basic features as found in other 
Windows based programs:

• Minimize, Maximize/Restore, and Close icons are located in the 
upper right corner of most views.

• Object icon, located in the upper left corner of most views, contains 
the normal Windows 3.x menu.

Most of the different views found in the program are resizable to some 
degree. 

The following list provides a brief description on resizable views:

• When the Minimize, Maximize/Restore and Close icons are 
available, the view can be resized vertically and horizontally.

• When only the Minimize and Close icons are available, the view 
cannot be resized.

• When only the Close icon or Close and Pin icons are available, the 
view cannot be resized.

2.3.3  Minimized Views
All views can be minimized. The Minimize icon in the upper right corner 
of the view is used for minimizing the view. Once a view has been 
minimized, only the Title bar is visible. It can be re-opened by double-
clicking on the minimized view or clicking the Restore icon which 
replaces the Minimize button in the minimized view. Minimizing and 
maximizing is analogous with other Windows-based applications.

Minimize icon

Maximize icon

Restore icon

Close icon

Pin icon

Minimized View

Restore icon
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2.3.4  Modal vs. Non-Modal Views
When a view is modal, you cannot access any other element in the case. 
That is, you cannot select a menu item or view that is not directly part of 
that modal view. Non-modal views do not restrict you in this manner. 
You can leave a non-modal view open and interact with any other view 
or menu item by selecting it.

Example of a modal and a non-modal views are shown in the figure 
below. 

Notice that the non-modal view is also the inactive view, indicated by 
the dull Title bar colour and positioned behind the active view. The 
modal view is the active view, indicated by the bright Title bar colour 
and position.

The modal view is indicated by presence of a Pin icon in the right corner 
of the view while the non-modal view is indicated by the Minimize, 
Maximize, and Close icons. A modal view with a Pin icon can be 
converted to a non-modal view by clicking on the Pin icon.

 Figure 2.4

Modal

Non-Modal

Pin icon
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2.3.5  Project View
The HI Project, Azeotropic Column Sequencing, and Column 
Sequencing views have the same general structure known as the project 
view. The figure below shows a typical project view at the Project level.

Level
There are three different hierarchical levels in a project view. Each level 
has a specific set of views associated with it. 

There can only be one top/first level in a project view. The first level can 
contain multiple sub-levels/second levels. Each second level can 
contain multiple sub-levels/third levels.

The information/objects in the project view also varies for different 
operations at different levels, except for the project level. The project 
level, as shown in Figure 2.5, contains the same fields, buttons, and 
groups for all operation project views. 

The project view type is only 
available in DISTIL and HX-
Net.

 Figure 2.5

Viewer pane Main pane

Double 
border

Worksheet

You can access all three 
levels by using the tree 
browser in Viewer pane. 
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Panes
The project view in the program is divided into three panes: Viewer, 
Main, and Worksheet. Each pane is outlined by a double border. You can 
resize each pane independently by clicking and dragging the double 
border surrounding the pane.

The following sections describes each pane for the project view at the 
top/first level. All operations with project view contains the same 
objects/options at the top/first level.

Viewer Pane

The Viewer pane contains the Viewer group. The group contains the tree 
browser which is used to access, create and delete projects, scenarios, 
and designs within the operation. 

The tree browser is a graphical representation of all levels existing in the 
project view, and is organized in a hierarchical format. Multiple 
Scenarios can “branch” off from the Project level, and multiple Designs 
can “branch” off from the Scenario level.

The following is the procedure to move from level to level in a project 
view:

1. Open the project view (e.g., HI Project or Column Sequencing).

2. In the Viewer group, select the level you want to enter.

3. Click the + or - icons to display or hide the scenario and design 
levels.

 Figure 2.6

Each pane will display 
different information 
depending on the active level.

The Viewer group appears in 
the project view for all levels.

When the Scenario level is 
selected, the Scenario name is 
highlighted, indicating that this 
is the active level.

Project 
level

Design 
level

Scenario level
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Main Pane

The Main pane contains different objects, depending on the level and 
operation. However for all operation at Project level, the Main pane 
contains two groups: Project Information and Project Comment.

Project Information Group

The Project Information group allows you to enter the operation/project 
name in the Name field, and the designer of the operation/project in the 
Engineer field. The Date display field displays the current date.

Project Comment Group

The Project Comment allows you to enter information regarding the 
operation/project in the text editor.

Worksheet Pane

The Worksheet pane contains different objects, depending on the level 
and operation. However for all operation at Project level, the Worksheet 
contains two groups: Notes and Selected Notes.

Notes Group

This Notes group list the notes that have been added to the operation/
project. You can add notes to the operation/project by clicking the Add 
button, change the title of the notes by entering a new name in the Title 
field, and delete notes by selecting the notes and clicking the Delete 
button. You can also read the notes already added by selecting the note 
in the list, the selected note will appear in the Selected Notes group.

Selected Notes

This Selected Notes group displays the selected notes. This group also 
allows you to modify the notes in the text editor, and enter/change the 
name of the notes in the Title field. The Date display field indicates 
when the note was last modified.

Any changes made to the 
information in the Project 
Comment text editor, will 
appear in the text editor 
located at the bottom of the 
Manager view when the Show 
Notes button has been 
clicked.

At Scenario and Design level, 
the Worksheet is the main 
interface area where you can 
input and view data 
concerning the operation/
project.
2-12



Interface 2-13
2.4  Interface Terminology
The following figures displays some common interface objects in the 
program views. The table below each figure list and describes the 
objects.     

 Figure 2.7

Scroll bar

Maximize icon

Close 
icon

Scroll 
button

Minimize icon

Matrix/
Table

Cell

Drop-down list

Button

Interface Object Definition

Drop-Down List A list of available options under a given menu item, or a list of 
acceptable responses to a certain input cell/field.

Minimize icon Reduces the current view into a Minimized view. Refer to 
Section 2.3.3 - Minimized Views for more information.

Maximize icon Expands the view to its maximum size.

Close icon Closes the view completely.

Matrix / Table Information displayed in a tabular format.  Rows of information 
go across the matrix horizontally, and are organized by 
variables into different columns, which run vertically. The top 
row of the matrix usually provides a description of the 
information for each column. 

Cell A location in a matrix or table for supplying or viewing 
information. Refer to Section 2.4.1 - Cells & Fields for more 
information.

For examples, a row of 
information might contain all 
information about one stream, 
and one column would 
contain the inlet temperatures 
for all streams. 
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Scroll Bar Used to access information which cannot be displayed in the 
current size of a menu or view.

Scroll Button Part of the Scroll Bar, this object allows you to slide up or down 
the list. There are also Scroll Buttons that slide the list left or 
right.

Button Invokes a command when clicked. Buttons are often used to 
perform actions, such as deleting or adding or starting 
calculations. Buttons can also be used to open up other views.

 Figure 2.8

Interface Object Definition

Operation Icon Clicking the icon will open a drop-down menu of common 
Windows commands. Double-clicking the icon will close the 
view.

Group The organizational border within a tab that groups related 
functions together. Each group has its own active location.

Field A single location in a view for supplying/entering data. Refer to 
Section 2.4.1 - Cells & Fields for more information.

Unit List Upon entering data in the active field or cell, a drop-down list of 
units which are applicable for the parameter type of the current 
input cell will appear.

Checkbox Indicates which items or settings are either active or inactive. 
When a checkbox is checked, a checkmark is displayed and 
the function is active. When a checkbox is unchecked, the 
checkbox is empty and the function is inactive. Clicking on the 
checkbox will toggle between checked and unchecked.

Radio Buttons Found in groups of at least two, with only one being active at 
one time. To change the radio buttons, click on the desired 
option, or the empty circle beside the desired option.

Interface Object Definition

Unit list

Field

Operation 
icon

Status Bar

Icon

Radio buttons

Group

Checkboxes in the Display 
column.
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Although several views can be displayed on the desktop at any time, 
only one view is active or has focus. This is indicated by the highlighting 
of the active view Title bar. Within a view, there is again only one 
location that is active.

The style in which an object is distinguished as active depends upon the 
type of object (cell, button, etc.). Active buttons have heavily shaded 
borders and a dashed/dotted frame around the button label. In the case 
of a cell in a matrix/table, an active cell is distinguished by a thick cell 
border and/or different background colour. For an item in a list, the 
active item is highlighted.

2.4.1  Cells & Fields
This is a location in a view for supplying or viewing information (e.g. 
stream names and temperatures). Cells are grouped as part of a matrix/
table, and fields are single cells in a view.

In some cases, fields or cells have an associated drop-down list, 
indicated by a down arrow (  or ) in the cell or field.

Red cross and 
Green checkmark

Usually found in a Selected column of a table. You can click on 
the red cross or green checkmark to toggle between not 
selected or selected status for the associated objects in the 
table.

Icon Invokes a command when clicked, an icon is exactly like a 
button.

Status Bar At the bottom of some individual views, tabs, and pages there 
is a colored bar(s).  This bar will change color and display 
different messages depending on the status of the information 
displayed or entered for the respective view, tab or page.

 Figure 2.9

Interface Object Definition

A green checkmark  
indicates that the object is 
selected. 

A red cross  indicates that 
the object is not selected.

For more information 
regarding active views, refer to 
Section 2.3.1 - Active 
Location.

This is shown in the left side 
of Figure 2.9. Clicking on the 
down arrow, as shown on the 
right side of Figure 2.9, to 
open/access the drop-down 
list.
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2.5  Manoeuvring Through 
the Interface

This software utilizes the Windows conventions regarding interaction 
between the user and the application. These are described below.

2.5.1  Hot Keys - ALT Key
Most labels such as the items on the menu bar, input cell identifiers, and 
button labels, have a single letter underlined. This letter works in 
conjunction with the ALT key as a hot key combination, the result of 
which varies depending on the label type.

• For the menu bar Items (File for example), pressing ALT F opens the 
drop-down menu under File.

• For field identifiers (Name for example), pressing ALT N moves the 
active location directly to that field. 

• For buttons (Add for example), pressing ALT A invokes the command of 
the button. 

The ALT key by itself automatically advances the active location to the 
first item in the menu bar (File). The keyboard arrows move left and 
right through the row, and the down arrow opens the active menu item. 
If a drop-down menu has underlined letters, you can invoke the 
command by using that letter only. For example, with the File menu 
open, you can start a new case by pressing the N key.

 Figure 2.10
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The following is a list of all hot key combinations and their related 
commands, including all ALT key combinations. 

Hot Key Combination Command

ALT E C

also CTRL C

ClipBoard Copy 

ALT E P

also CTRL V

ClipBoard Paste

ALT E T

also CTRL X

ClipBoard Cut 

ALT F A

also CTRL SHIFT S

Save Case with another name

ALT F D

also CTRL SHIFT D

Set Case Description

ESC Cancel previous action

F1

also ALT H C

Displays Help Contents

ALT F4

also ALT F X

Exit the program 

CTRL C

also ALT E C

ClipBoard Copy 

CTRL N

also ALT F N

Create a new case

CTRL O

also ALT F O

Open an existing case

CTRL S

also ALT F S

Save current case

CTRL V

also ALT W P

ClipBoard Paste

CTRL X

also ALT E T

ClipBoard Cut 

CTRL F4

also ALT W C

Close current Window

CTRL F6

also ALT W D

Send the front window to the back

SHIFT F4

also ALT W E

Close all Windows

ALT F H Print a snapshot of the active form

ALT F N

also CTRL N

Create a new case

ALT F O

also CTRL O

Open an existing case
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2-18 Manoeuvring Through the Interface
ALT F P Print active forms of the Specsheet or Graphic

ALT F S

also CTRL S

Save current Case

ALT F U G Setup Printer for printing the PFDs, Plots, or Snapshots

ALT F U R Setup Printer for printing Reports, Specsheet, or Text

ALT F X

also ALT F4

Exit the program 

ALT H A Displays Information about the program

ALT H B Submit or edit Bug Reports

ALT H C

also F1

Displays Help Contents

ALT I P Displays Heat Integration Project 

ALT I M Displays Heat Integration Manager 

ALT I C Displays Heat Integration Case

ALT T P Access to user preferences 

ALT T S Access the Script Manager 

ALT W C

also CTRL F4

Close current Window

ALT W D

also CTRL F6

Arrange desktop Windows

ALT W E

also SHIFT F4

Close all Windows

ALT W I Arrange Icons at bottom of Screen

ALT W L Load a Previously Saved Window Layout (or a Hidden 
Case)

ALT W S Save Current Window Layout for Future Use

CTRL SHIFT S

also ALT F A

Save Case with another name

CTRL SHIFT D

also ALT F D

Set Case Description

CTRL SHIFT F6 Bring the last window to the front

Hot Key Combination Command
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2.5.2  Moving Through a View
Each cell, field, and button on a view is sequenced. You can move the 
active location using the TAB (forward direction) and SHIFT TAB (reverse 
direction) keys. 

If the active location is on a cell in a matrix, the TAB key will not advance 
you to the next cell in that matrix, but rather to the next active location 
in the view (this can be a button or a field). 

In some instances, such as input matrix found in the HI Case view, 
Process Streams tab, you will automatically advance to the next input 
cell when you press ENTER.

The active location of the cursor in a view is indicated in one of three 
ways.

• In the case of a string (e.g. Name field), the entire string in the field will 
be reverse highlighted.

• If the cell/field is numerical, another border is placed outside/inside the 
cell/field border.

• In the case of a button, the perimeter of the button will be highlighted 
and the label will be surrounded by a dashed frame.

 Figure 2.11

There are two ways to move 
the active location:

• Move the mouse pointer 
to the object and click. 

• Pressing the TAB key.

If H2O was the active cell, pressing TAB would 
advance the active location to the Edit Table button, 
while pressing SHIFT TAB would move back the active 
location to Toggle Phase button.

Shows the last 
active location in 
the matrix

Shows a field as the active location.
2-19



2-20 Manoeuvring Through the Interface
2.5.3  Entering Data

Supplying Input in Cells/Fields
When the required input is a name of an item (e.g., stream, utility, fluid 
package, etc.), you can either supply the input directly via the keyboard, 
or in some cases (e.g., selecting a Utility Stream name) select the item 
from a drop-down list of appropriate responses.

If you are supplying the input from the keyboard, (e.g., creating a new 
stream), click in the cell/field, then enter the text and press ENTER. 

If the input is numerical, the approach is slightly different. When you 
begin supplying a number for a numerical cell/field, your input is 
displayed in the cell/field and the Unit list appears beside the cell/field. 
The Unit list is like a drop-down list that displays the current default unit 
for the cell/field property. When you have supplied the number and 
press ENTER, the program assumes that the default unit is the selected 
unit for the value entered.

If you are supplying the number in a unit other than the default, there 
are two methods available for identifying your unit. 

 Figure 2.12

Input Method Description

Keyboard Enter a space after the number and then begin typing in the name of 
the unit. The drop-down list of available units opens, and the entered 
unit will be highlighted in the drop-down list.

Mouse After supplying the numerical value, but before pressing ENTER, 

open the drop-down list by clicking on the down arrow  and select 
the desired unit from the list.

If a cell/field allows for 
selection from a drop-down 
list, the cell/field will contain a 
down arrow  at the right 
side of the cell/field.

The Unit list shows 
the default units, bar.

As numerical input for a 
parameter is supplied, the 
value appears in the field.
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Drop-down Lists and Scroll Bars
Drop-down list provides a list of commands/options to choose as input. 
These commands/options can be accessed via the mouse, or by 
keyboard input. Once a drop-down list is opened, manoeuvring through 
the list is accomplished with the mouse or keyboard.

A drop-down list for a text cell/field can be opened at any time by 
clicking the appropriate arrow within the cell/field. This opens the drop-
down list and moves the active location to that cell/field. You can also 
open the drop-down list for the current active cell/field by pressing the 
SPACE BAR and then the keyboard down arrow.

For a numerical cell/field, refer to the above Supplying Input in Cells/
Fields section for information.

Once a drop-down list is opened, you can manoeuvre through it in 
several methods.

• The most convenient method is via type-matching. Once a drop-
down list is opened, keyboard input is interpreted to find the first 
menu item which best matches your input. As you continue to supply 
input, the matching continues. Pressing ENTER terminates the string 
and accepts the highlighted item. You can also use the keyboard 
arrow keys to move to any item.

• If the menu does not have many items, it appears without scroll 
bars. In this case, you can use the mouse to directly select the 
desired item, or use the up and down keyboard arrows to mark the 
item and then select it with the ENTER key.

 Figure 2.13

A drop-down list is indicated 

by a down arrow (  or ) 
within the cell or field.

Click to move 
up one item

Scroll button

Click to scroll 
down one page

Click to move down one Item

The keyboard Up and Down 
arrows can be used to move 
through the list. Pressing 
ENTER selects the highlighted 
item. The mouse can also be 
used to select the item 
directly.
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• In addition, the PAGE UP and PAGE DOWN keys move the menu one 
page, and the HOME and END keys take you to the first and last item, 
respectively. The desired item is selected by highlighting it and 
pressing ENTER.

• The Scroll Bar/Scroll Button provides similar functionality. Clicking 
the Up and Down Scroll Arrows advance the menu one item. The 
scroll button can be clicked and dragged up and down to quickly 
scroll the menu. The desired item can then be selected by clicking 
on it.

• Clicking the space between the scroll button and the scroll arrow 
advances the menu up or down one page. The desired item can 
then be selected by clicking on it.

Editing Input
Editing input for a text cell/field can be done in two ways:

• When the cell/field is active, any input you supply will overwrite the 
previous input. In some cases, if you want to edit the text and not 
completely overwrite the information, you can click in the active 
location (the cell or field) again to reposition the cursor.

• You can use the drop-down list to replace the previous input

You have a choice when editing numerical input.

• Click the cell/field to make it the active location, then type in a new 
value and press ENTER. The input is accepted assuming the default 
units.

• You can change the units of a cell/field by activating the cell/field you 
want to change, positioning the cursor at the end of the value and 
pressing the SPACE BAR. You can then either select the new unit from 
the drop-down list or typematch the unit. 

• Another method is via selective modification. With this route, you 
place an insertion point somewhere in the string and make selective 
changes. 

You can use the mouse 
pointer to make an insertion 
point somewhere in the 
number and make selective 
changes.
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2.5.4  Closing Views
There are four ways to close a view:

• Double-click on the Operation icon in the upper left corner of the 
view.

• Click once on the Object icon to open the drop-down menu. The 
Close command in this drop-down menu has the C underlined. 
Press the C on the keyboard to close the view.

• Click the Close icon.
• CTRL F4 closes the active view.

 Figure 2.14

Object icon menu Close icon 
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2.6  Trace Window
At the bottom of the desktop, there is a window that displays status 
messages and detailed solver information. This window is referred to as 
the Trace Window.

2.6.1  Opening and Sizing the Window
To open the Trace Window, position the mouse pointer on any part of 
the extra thick border directly above the status bar. When the mouse 

pointer changes to a sizing arrowhead , click and drag the border 
vertically.

2.6.2  Available Information
The Trace Window has three main functions:

• It displays iterative calculations for certain operations. These are 
shown in black.

• It displays scripting commands, shown in blue.
• If an operation has an error or warning, but still solves, this message 

is shown in red.

An example of the contents shown in the Trace Window is displayed in 
the figure below. The Trace window has a vertical scroll bar, which allows 
you to move through its contents. 

The Trace Window cannot be 
opened separately.

 Figure 2.15
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2.6.3  Object Inspect Menu
You can access the Object Inspect menu of the Trace Window by placing 
the mouse pointer over the Trace Windows and right-click. The figure 
below displays the Object Inspect menu. 

The commands available in the Object Inspect menu for the Trace 
Window are:

 Figure 2.16

Command Description

View Trace Properties Allows you to open the Trace Properties view as shown in 
the figure below:

The features available in the Trace Properties view are:
• Trace File Name. This field displays the file name to 

which the contents of the Trace Window can be 
written (by default Trace.Log).

• History Length. This field represents the number of 
lines that the Trace Window keeps in its history.

• Trace to File Continuously. When this checkbox is 
checked, the Trace Window contents are written to 
the Trace File.

• Verbose. When this checkbox is checked, the Trace 
Window displays solver information for all the 
operations in the case.

Set trace window font Allows you to select the font size and type that appears in 
the Trace Window.

Dump Current Trace to 
File

Allows you to dump the current contents of the Trace 
Window into the Trace File. 

Clear Trace Window Clears all the information from the Trace Window.

Copy all trace 
information

Allows you to copy all the information in the Trace Window 
in to the clipboard.
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3-2 File Menu
3.1  File Menu
The File menu is the first menu available in the menu bar. The file menu 
contains most of the commands related to manipulating files and all the 
print commands available in the program. The figure below displays the 
File menu. 

You can access the File menu by doing one of the following:

• Move mouse pointer over the File menu in the menu bar and click.
• Press ALT F.
• Press ALT and press the down arrow key.

If you have previously saved a case in the program, the case name will 
appear below the Exit command. You can select the case name to open 
the case, without using the Open command. The program’s quick access 
to case option stores up to five cases.

 Figure 3.1
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3.2  New Command
The New command creates a new case. If a case is opened when the 
command is selected, you will be prompted to save the current case if 
there have been changes since the last save.

To create a new case:

1. Open the File menu and select New.
• If you have an active case that has not been modified since its 

last save, Concept will close the active case.
• If you have an active case that has not been saved, the program 

will open a view that prompts you to select one of the three 
options: save the case, close the case without saving, or abort 
creating a new case.

2. After ensuring there are no active case, the program create a new 
case. The new case is indicated by the blank desktop and the 
NoName.hcd in the title bar.

Alternatively, you can also create a new case by clicking the New Case 
icon.

You can have only one file open at any time. So whenever you create a 
new case or open a file, the program closes any active case in the 
program before the new case is created or selected file is opened.

 Figure 3.2

You can also press CTRL N to 
access the New command.

New Case icons
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3.3  Open Command
The Open command opens an existing case. If a case is open when the 
command is selected, you will be prompted to save the current case if 
there have been changes since the last save.

To open an existing case:

1. Select File-Open from the menu bar.
• If you have an active case that has not been modified since its 

last save, Concept will close the active case.
• If you have an active case that has not been saved, the program 

will open a view prompting you to either save the case, close the 
case without saving, or abort creating a new case.

2. After ensuring there are no active case, the program opens the Open 
Case view.

3. Select the case you want to open and click the Open button.

You can have only one file open at any time. So whenever you create a 
new case or open a file, the program closes any active case in the 
program before the new case is created or selected file is opened.

 Figure 3.3

You can also press CTRL O to 
access the Open command.

Alternatively, you can also 
open a case by clicking the 
Open Case icon.
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3.4  Save Command
The Save command saves the active case of the program as a *.hcd file. 
When saving a case for the first time, use the Save command and supply 
the file name and file path. 

To save a new case:

1. Open the File menu.

2. Select the Save command.

3. The program will open the Save Case view.

4. You must enter a name for the file in the File name field. 
You can also select where the file is to be saved using the Save in 
drop-down list. 

5. Click the Save button, when you are done entering the name and 
selecting the file path. The Save Case view will close, and the 
program will save the new case with the appropriate file extension, 
*.hcd. 

If the case has been previously saved, the Save command updates the 
information in the file. 

 Figure 3.4

You can also press CTRL S to 
access the Save command.

The program automatically 
saved the case in the default 
file folder. Refer to section 
Locations Page from 
Section 5.4.4 - Files Tab for 
more information regarding 
the default file folder.
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To save a previous case:

1. Open the File menu.

2. Select the Save command.

3. The program will save the active case in the same file path. The 
existing case in the disk is replaced with the active case.

You can also save a case by clicking the Save Case icon. The Save Case 
icon has the same function as the Save command.

3.5  Save As Command
The Save As command saves the active case of the program as a *.hcd 
file. If you want to change the file name or location of a previously saved 
case, use the Save As command. 

To save a previous case as a new name or in new file path:

1. Open the File menu.

2. Select the Save As command.

3. The program will open the Save Case view.

 Figure 3.5

Save Case icon

You can also press CTRL SHIFT 
S to access the Save As 
command.
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4. You can enter a new name for the file in the File name field. The 
program automatically attaches the appropriate file extension, 
*.hcd.
You can also select a different file path for the file using the Save in 
drop-down list.

3.6  File Description
When you select the File Description command, the File Description 
view appears. The File Description provides a simple text editor for you 
to enter a description of the case. 

The information entered in the File Description view is saved when you 
save the file. So if somebody else open the file, they can access the File 
Description view and read what the file is about.

 Figure 3.6

For effectiveness, the program recommends the File Description be 
used to describe the overall file, not a specific operation or project 
within the file.

The program automatically 
saved the case in the default 
file folder. Refer to section 
Locations Page from 
Section 5.4.4 - Files Tab for 
more information regarding 
the default file folder.

You can also press CTRL SHIFT 
D to access the File 
Description view.
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3.7  Print Commands
There are three print commands available under the File menu.

The table below lists and describes the three print commands:

 Figure 3.7

Command Description

Print Allows you to open the Select Datablocks to Print view. This view 
lists the available Datasheets for the currently active object. You can 
select a Datasheet and either preview or print it. Refer to Section 
3.7.1 - Printing Datasheet for more details.

Print Snapshot Allows you to print a bitmap of the currently active view. Use this 
command when you want to print a view that does not have a 
Datasheet associated with it. Plots can be printed using this 
command.

Printer Setup Opens a sub-menu containing two commands: Graphic Printer and 
Report Printer.

If you select the Graphic Printer command, the Print Setup view for 
graphics appears. The Print Setup view allows you to select the 
printer, paper orientation, paper size and source. Use the Graphic 
Printer command to setup the printer when printing plots and 
snapshots.

If you select the Report Printer command, the Print Setup view for 
reports appears. The Print Setup view allows you to select the 
printer, paper orientation, paper size and source. Use the Report 
Printer command to setup the printer when printing Datasheets, 
reports, and text.

The Print Setup view varies 
with different printers.
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3.7.1  Printing Datasheet
The Datasheet displays all Worksheet-related information, which can 
include input specifications and calculated results. You can customize 
the information displayed in the Datasheet on the Select Datablocks to 
Print view. 

To access the Select Datablocks to Print view:

1. Select the view containing the information you want to print.

2. Then select the Print from the File menu.

The figure below displays the Select Datablocks to Print view for an 
Azeotrope Analysis view.

The following table lists and describes the object in the Select 
Datablocks to Print view:

 Figure 3.8

Object Description

Available 
Datablocks list

Contains all the Worksheets available for the Datasheet of the 
selected view. You can expand the list by clicking the “+” 
symbols beside the Worksheet, or shrink the list by clicking the 
“-” symbols beside the Worksheet.

You can select which Worksheets will appear in the Datasheet 
by checking or unchecking the corresponding checkboxes in 
the Available Datablocks group. 

Select All button Allows you to check all the Worksheet in the Available 
Datablocks list, thus informing the program to include all the 
Worksheets information into the Datasheet.

Invert Selection 
button

Allows you to reverse the status of all the checkboxes in the 
Available Datablock list. So any checked checkboxes in the list 
becomes uncheck and vice versa for unchecked checkboxes.

The list of available 
datablocks in the Select 
Datablocks to Print view 
varies depending on the 
selected view.
3-9



3-10 Print Commands
Set Preferences 
button

Allows you to save the current status of the Worksheet 
checkboxes in the list as a preference. You can apply the saved 
preferred selection/preference into other Datasheets with the 
same view type.

Use Preferences 
button

Allows you to apply the saved preference on to the Datasheet 
of the current view. If no preference was saved, the program 
default preference setting is applied. The default preference is 
to include all the available Worksheet into the Datasheet. 

Print button Allows you to print a physical copy of the Datasheet using the 
current setup on the Select Datablocks to Print view. 

Text to File 
checkbox

Check this checkbox to print the Datasheet to an ASCII file.

When this checkbox is checked the Delimited checkbox is 
made active and the Format button replaced the Format/Layout 
button.

Delimited checkbox Check this checkbox to apply the delimiter in the ASCII file.

This checkbox is only available if the Text to File checkbox is 
checked.

Preview button Allows you to open the Report Preview view. The Report 
Preview view contains an image of how the printed Datasheet 
will look like. Refer to section Report Preview View for more 
information.

Format/Layout 
button

Allows you to open the Session Preferences Format / Layout 
view. This view allows you to manipulate the format and layout 
of the Datasheet. 

The view is also the same as the Reports tab, Format / Layout 
page in the Session Preference view. For more information 
regarding the Session Preferences Format / Layout view, refer 
to Section 5.4.3 - Reports Tab.

Format button Allows you to open the Session Preferences Text Format view. 
This view allows you to manipulate the format of the Datasheet.

The view is also the same as the Reports tab, Text Format 
page in the Session Preference view. For more information 
regarding the Session Preferences Text Format view, refer to 
Section 5.4.3 - Reports Tab.

Print Setup button Allows you to open the Print Setup view. This view allows you 
to select the printer, the paper orientation, the paper size, and 
the paper source.

Object Description

Example:

You can save a preference for 
the Column Design view, and 
apply the preference to a 
different Column Design view. 
However, you cannot apply 
the preference to an 
Azeotrope Analysis view.

This button is available when 
the Text to File checkbox is 
unchecked.

This button is available when 
the Text to File checkbox is 
checked.
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Report Preview View
The Report Preview view allows you to see the Datasheet before printing 
a physical copy or saving the Datasheet as a text file. The figure below 
displays a Report Preview view of a Heat Interrogation case.

The following table lists and describes the objects available on the 
Report Preview view:

 Figure 3.9

Object Icon Description

Format/Layout 
button

Allows you to open the Session Preferences Format / 
Layout view. This view allows you to manipulate the 
format and layout of the Datasheet. 

The view is also the same as the Reports tab, Formate / 
Layout page in the Session Preference view. For more 
information regarding the Session Preferences Formate / 
Layout view, refer to Section 5.4.3 - Reports Tab.

Print Setup 
button

Allows you to open the Print Setup view. This view allows 
you to select the printer, the paper orientation, the paper 
size, and the paper source.

Update button Allows you to update the information/values on the 
Datasheet.

Print button Allows you to print the current Datasheet.

Close button Allows you to close the Report Preview view.

Zoom Out icon Allows you to zoom out/away from the Datasheet image.

To access the Report Preview 
view, click the Preview button 
on the Select Datablocks to 
Print view. 
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3-12 Exit Command
3.7.2  Printing Plots
There are two methods to print a plot:

• Select the plot view, and then select the Print Snapshot from the 
File menu.

• Right-click the plot area and select the Print Plot command from the 
Object Inspect menu.

3.8  Exit Command
Select the Exit command to close and leave the program. You will be 
prompted to save the current case if any changes occurred since the last 
save.

ZoomFit icon Allows you to resize the width of Datasheet image to fit 
into the current view.

Zoom In icon Allows you to zoom in/towards the Datasheet image.

Object Icon Description

For more information about 
printing plots, refer to Section 
8.5 - Print Plot

You can also press ALT F4 to 
access the Exit command.
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4-2 Edit Menu
4.1  Edit Menu
The following commands are available in the Edit menu:

4.2  Managers Menu
The Managers menu contains a list of commands to open the various 
manager views. Depending on which program package you bought, 
some commands may be unavailable.

You can access the Managers menu by doing one of the following:

• Move mouse pointer over the Managers menu in the menu bar and 
click.

• Press ALT M.

4.2.1  DISTIL
In DISTIL, the following commands are available in the Managers 
menu:

Command Description

Cut Allows you to remove the selected cell(s) from the current view. You 
can then use the Paste function to place the removed cell(s) in 
another location or in another application.

Copy Allows you to copy the selected cell(s) to the Clipboard. You can 
then use the Paste function to place the copied cell(s) in another 
location or in another application.

Paste Allows you to place the copied or cut selections in the location of 
your choice.

 Figure 4.1

Edit menu
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A brief description of each command is provided in the table below 
along with a link to the chapter that contains more information about 
the command: 

4.2.2  HX-Net
In HX-Net, the Managers menu contains only one command:

• Heat Integration Manager. Allows you to open the Heat Integration 
Manager view. This view manages the creation, deletion, and 
modification of the two Heat Integration operations: HI Projects and 
HI Cases.

Command Description For more information:

Fluid Package 
Manager

Allows you to open the Fluid Package Manager view. This 
view manages fluid packages which are the basis for 
some simulation cases.

Refer to Chapter 9 - Fluid 
Package Manager.

Stream Manager Allows you to open the Stream Manager view. This view 
contains a number of material streams.

Refer to Chapter 6 - 
Stream Manager from the 
Thermodynamic 
Workbench manual.

Thermodynamic 
Workbench Manager

Allows you to open the Thermodynamic Workbench 
Managers view. This view manages the creation, deletion, 
and modification of the four thermodynamics operations: 
Phase Equilibrium, Property Table, Pure Component 
Regression, and Fluid Phase Regression.

Refer to Chapter 1 - 
Thermodynamic 
Workbench Manager from 
the Thermodynamic 
Workbench manual.

Separation Manager Allows you to open the Separation Manager view. This 
view manages the creation, deletion, and modification of 
the four separation operations: Simple Column, Three 
Product System, Column Sequencing, and Complex 
Column.

Refer to Chapter 1 - 
Separation Manager from 
the Separation manual.

Azeotropic 
Separation Manager

Allows you to open the Azeotropic Separation Manager 
view. This view manages the creation, deletion, and 
modification of the six separation operations: Azeotrope 
Analysis, Residue Curve Map, Distillation Region 
Diagrams, Column Design, Azeotropic Column 
Sequencing, and Split Generator.

Refer to Chapter 1 - 
Azeotropic Separation 
Manager from the 
Azeotropic Separation 
manual.

 Figure 4.2

Refer to Chapter 1 - Heat 
Integration Manager from 
the Heat Integration manual.
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4.3  Features Menu
The Features menu contains a list of commands to open the operation/
tool property views. Depending on which program package you bought, 
some commands may be unavailable.

You can access the Features menu by doing one of the following:

• Move mouse pointer over the Features menu in the menu bar and 
click.

• Press ALT F.

4.3.1  DISTIL
In DISTIL, the following commands are available in the Features menu:

 Figure 4.3
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A brief description of each command is provided in the table below 
along with a link to the chapter that contains more information about 
the command: 

Command Description For more information:

Pure Component 
Regression

Allows you to access/create a new Pure 
Component Regression operation. 

Refer to Chapter 4 - Pure 
Component Regression from the 
Thermodynamic Workbench 
manual. 

Fluid Phase 
Regression

Allows you to access/create a new Fluid Phase 
Regression operation.

Refer to Chapter 5 - Fluid Phase 
Regression from the 
Thermodynamic Workbench 
manual.

Property Table Allows you to access/create a new Property 
Table operation.

Refer to Chapter 3 - Property Table 
from the Thermodynamic 
Workbench manual.

Phase Equilibrium 
Properties

Allows you to access/create a new Phase 
Equilibrium Properties operation.

Refer to Chapter 2 - Phase 
Equilibrium from the 
Thermodynamic Workbench 
manual.

Simple Column 
Design

Allows you to access/create a new Simple 
Column Design operation.

Refer to Chapter 4 - Simple Column 
from the Separation manual.

Complex Column 
Design

Allows you to access/create a new Complex 
Column Design operation.

Refer to Chapter 2 - Complex 
Column from the Separation 
manual.

Column Sequencing Allows you to access/create a new Column 
Sequencing operation.

Refer to Chapter 5 - Column 
Sequencing from the Separation 
manual.

Three Product 
Systems

Allows you to access/create a new Three 
Product Systems operation.

Refer to Chapter 3 - Three Product 
System from the Separation 
manual.

Azeotrope Analysis Allows you to access/create a new Azeotrope 
Analysis operation.

Refer to Chapter 2 - Azeotrope 
Analysis from the Azeotropic 
Separation manual.

Distillation Region 
Diagram

Allows you to access/create a new Distillation 
Region Diagram operation.

Refer to Chapter 5 - Distillation 
Region Diagram from the 
Azeotropic Separation manual. 

Residue Curve Map Allows you to access/create a new Residue 
Curve Map operation.

Refer to Chapter 6 - Residue Curve 
Map from the Azeotropic 
Separation manual.

Graphical Column 
Design

Allows you to access/create a new Column 
Design operation.

Refer to Chapter 4 - Column Design 
from the Azeotropic Separation 
manual.

Split Allows you to access/create a new Split 
Generator operation.

Refer to Chapter 7 - Split Generator 
from the Azeotropic Separation 
manual.

Column Sequencing Allows you to access/create a new Azeotrope 
Column Sequencing operation.

Refer to Chapter 3 - Azeotropic 
Column Sequencing from the 
Azeotropic Separation manual.
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4.3.2  HX-NEt
In HX-Net, the following commands are available in the Features menu:

A brief description of each command is provided in the table below 
along with a link to the chapter that contains more information about 
the command:

 Figure 4.4

Command Description For more information:

HI Case Allows you to access/create a 
new Heat Integration Case 
operation.

Refer to Chapter 2 - Heat 
Integration Case from the Heat 
Integration manual.‘

HI Project Allows you to access/create a 
new Heat Integration Project 
operation.

Refer to Chapter 4 - Heat 
Integration Project from the 
Heat Integration manual.
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5-2 Tools Menu
5.1  Tools Menu
You can access the Tools menu by doing one of the following:

• Move mouse pointer over the Tools menu in the menu bar and click.
• Press ALT T.

The following commands are available in the Tools menu: 

5.2  Script Manager Command
The Script Manager view is a tool that records all your case interaction, 
with respect to all information specified. The recorded script can be 
played back at a later time. Select the Tools-Script Manager command 
from the menu bar to open the Script Manager view. 

 Figure 5.1

Command Description

Script Manager Allows you access to the Script Manager.

Macro Language Editor Allows you access to the program’s Macro Language 
Editor view.

Preferences Allows you access to the Session Preferences.

 Figure 5.2
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The following are some important points when using the Script feature:

• Changes made in the Session Preferences are not saved in the 
script.

• Scripting is always done in the program internal units.
• Scripting is Name specific, so stream and operation names in a 

script must be identical to those in the case in which you are running 
the script.

• For the playback of a script, the simulation case MUST BE 
EXACTLY as it was when the script was recorded, so that the 
program can perform all the steps in the script.

5.2.1  Recording
The procedure for recording a new script is as follows:

1. Save your simulation case. Since the case must be in exactly the 
same condition for playback of the recorded script, this is generally 
a good idea.

2. Open the Tools menu.

3. Select Script Manager. The Script Manager view appears.

4. Select a directory from the Directories list in which the script file will 
be saved.

5. Click the New button. The program closes the Script Manager view 
and displays the New Script view.

6. Enter a name in the Name field for the script. If you want, you can 
also enter a description for the script in the Description field. 
If you did not add an extension to the script file name, the program 
automatically adds the *.scp extension.

7. Click the Record button to start recording. The program closes the 
New Script view. Notice the red Record icon in the lower right corner 
of the desktop.

8. Perform each task that you want to record.

 Figure 5.3

Record icon
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9. When you finish recording commands, open the Script Manager 
view and click the Stop Recording button.

If you would like to save the case, DO NOT save it with the same name as 
in step #1, as this will prevent you from playing back the script.

5.2.2  Playback
In order to play a script, the simulation case must be in the same state as 
it was prior to the recording of the script.

Follow this procedure to play a script:

1. Open the case that is associated with the script.

2. Open the Tools menu.

3. Select Script Manager. The Script Manager view appears.

4. Select the script name in the Script Files list. If your script is not 
listed in the default directory, you can select a different path in the 
Directories list.

5. Click the Play button. The program closes the Script Manager view 
and begins playing back the script. Notice the green Playback icon 
in the lower right corner of the desktop.

The steps of the script playback are shown in the Trace Window.

At any time during the 
playback, you can stop the 
script by opening the Script 
Manager view and clicking the 
Stop Play button.

Playback icon
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5.3  Macro Language Editor
Selecting the Macro Language Editor command opens the program’s 
Macro Language Editor view as shown below.

The Macro Language Editor is an interactive design environment for 
developing, testing, and executing WinWrap Basic scripts. The editor 
uses a syntax that is similar to Microsoft Visual Basic®. 

 Figure 5.4

For more information, 
consult the Online 
help by selecting 
Help-Editor Help in 
the menu bar of the 
Macro Language 
Editor view.
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5.4  Preferences
The Session Preferences view in the program is used to specify default 
information for the simulation case. This information includes Units, 
Colours, Fonts, Icons, etc., for the simulation. The Session Preferences 
can be saved for the use in other files, and more than one Session 
Preferences can be created and saved.

You can open the Session Preferences view by selecting Preferences 
from the Tools menu. The Session Preferences view contains five tabs: 
General, Variables, Reports, Files, and Resources. 

Common to each tab are the two icons along the bottom of the Session 
Preference view.

Saving a Session Preference

To save a preference file:

1. Click the Save preference file icon. The Save Preference File view 
appears.

2. Specify the name and location for your preference file.

3. Click the Save button.

Loading a Session Preference

To load a preference file:

1. Click the Load preference file button. The Open Preferences File 
view appears.

2. Browse to the location of your preference file (*.prf).

3. Select the file you want to load and click the Open button.

Name Icon Description

Save 
preference file

Allows you to save the preference to a file. You must 
provide a new file name and/or location to which the 
preference is saved.

Load 
preference file

Allows you to load the saved preferences from a previous 
program session.

The Session Preferences 
view can be accessed only 
through the Tools menu.

Save preference file icon

Load preference file icon
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5.4.1  General Tab
The General tab shown in the figure below contains three groups: Errors, 
Show ToolTips, and Data Extraction. 

Data Extraction Group

The Data Extraction group allows you to specify the version of the Aspen 
Plus backup file you are going to extract information from. For example, 
the simulation file that contains the information you want was created 
in Aspen Plus version 11.1. Enter 11.1 in the Aspen Plus Version field. 

Errors Group

The Errors group contains two checkboxes which when checked will 
send the specified errors to the Trace Window. When these checkboxes 
are checked, you will not be prompted to acknowledge errors.

 Figure 5.5

The value in the Aspen Plus Version field is only applicable to HX-Net.
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Show ToolTips Group

Tooltip is a pop up or fly by that contains information related to an 
object. The tool tips are displayed by placing the mouse pointer over the 
associated object. 

The Show ToolTips group contains five checkboxes that allows you to 
customize what information appears on the tool tips.

• Show ToolTips. Check this checkbox to display the tool tip for 
objects that contain tool tip information.
When the Show ToolTips checkbox is checked, the Use ToolTips 
checkbox in the Resources tab, Cursors page will also be checked.

• Value in EuroSI Units. Check this checkbox to display the EuroSI 
units in the tool tips. Uncheck this checkbox to remove the EuroSI 
units from the tool tips.

• Value in Field Units. Check this checkbox to display the Field units 
in the tool tips. Uncheck this checkbox to remove the Field units from 
the tool tips.

• Value in SI Units. Check this checkbox to display the SI units in the 
tool tips. Uncheck this checkbox to remove the SI units from the tool 
tips.

• Value Calculated By. Check this checkbox to display the method of 
calculation in the tool tips. Uncheck this checkbox to remove the 
method of calculation units from the tool tips.

For instance, you can view 
stream data in the Data tab, 
Process Streams page of a HI 
Case view, by placing the 
cursor over any cell in the table 
and the tool tip appears.
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5.4.2  Variables Tab
The Variables tab contains two pages: Units and Formats.

Units Page
The Units page allows you to select the unit that is to be used in the 
current session.

The Unit page contains two groups: Available Unit Sets and Display 
Units.

The following table contains a list and description of the objects in the 
Available Unit Sets group: 

 Figure 5.6

Object Description

Available Unit 
Sets list

Allows you to select the unit set for the current session and contains 
all the unit sets available in the current session.

Clone button Allows you to clone a default unit set. You can only modify custom 
unit set. Refer to section Adding a New Unit Set for more 
information.

Delete button Allows you to delete only custom unit sets. Refer to section Deleting 
a Unit Set for more information.

Unit Set Name 
field

Displays the name of the selected unit set. You can only modify 
names of the custom unit sets.
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The following table contains a list and description of the objects in the 
Display Units group:

The program has three default unit sets. The default unit sets are: 
EuroSI, Field, and SI. These three sets are fixed, in which none of the 
units associated to the variables can be changed. Since you want to 
display information in units other than the default, the program allows 
you to create your own custom unit sets.

Adding a New Unit Set

You can create the new custom unit sets by cloning an existing set and 
altering it. The procedure is as follows:

1. Select the unit set you want to modify from the Available Unit Sets 
group.

2. Click the Clone button. 

Object Description

Display Units 
table

Contains a list of variables and the units associated to the variables. 
The units associated to the variables changes depending on the unit 
set selected. You can only modify the units associated to the 
variables of a custom unit set. Refer to section Change the Unit of 
a Variable for more information.

View button Allows you to see the unit conversion of the selected unit from the 
Display Units table.

Add button Allows you to add a unit conversion for the selected variable from 
the Display Units table.You can only add new conversion units for 
the variable of a custom unit set. Refer to section Adding a Unit 
Conversion for more information.

Delete button Allows you to delete a user added unit conversion from a variable of 
a custom unit set.

 Figure 5.7

You cannot delete the 
program’s default unit sets.
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The programs clones the selected unit set and automatically gives a 
default name to the new unit set. The default name is NewUser.

3. The default name appears in the Available Unit Sets list and in the 
Unit Set Name field. Notice that the text in the Unit Set Name field is 
blue in colour, which means you can change the default name. 

The units used in the new unit set are the same as the unit set you 
cloned.

Change the Unit of a Variable

To the change the units in a unit set:

1. From the list of Available Unit Sets, select the unit set you want to 
use for your simulation.

2. In the Displayed Units group, select the unit of the variable you want 
to change (e.g., Temperature).

3. With the focus in the Temperature unit cell, click the down arrow  
to open a drop-down list. The drop-down list shows all available 
convertible units for that unit type. 

4. From the list, click the unit you want use as your base unit for your 
simulation.

 Figure 5.8

You can not modify the units in 
any of the three default unit 
sets: SI, Field, and Euro SI.

With the focus in the 
appropriate cell, you can also 
press the SPACE BAR to open 
the drop-down list.

For Temperature, 
you see C, K, F, and 
R and any user 
conversions that 
were created.

This selection does not 
change the program’s internal 
unit set.
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Deleting a Unit Set 

To delete a unit set:

1. Select the unit set you want to delete from the list in the Available 
Unit Sets group.

2. Click the Delete button.

Viewing a Unit Conversion

The program performs its calculations in an internal unit set, and every 
other unit is converted from these default units. The View button allows 
you to view the conversion factor that the program uses to convert from 
its internal unit (SI) to the unit chosen in your unit set. You can view the 
conversion for any available unit.

To view a unit conversion:

1. From the list of Available Unit Sets, select the unit set you want to 
use for your simulation.

2. In the Displayed Units group, select the unit for which you want to 
view the conversion.

3. Click the View button to display the Conversion view.

The Name field displays the name of the unit. The field next to the Name 
field displays the conversion factor. Notice the text in the fields are all 
black, indicating that this is a View Only field. You cannot change the 
contents in any of the fields.

4. Click the OK or Cancel button to close the view.

You will not be prompted to confirm the deletion of a unit set, so ensure 
that you have selected the correct unit set to delete.

 Figure 5.9

You can not delete the three 
default unit sets: SI, Field, and 
Euro SI.
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Adding a Unit Conversion

If you require a unit that is not available in the program’s database, you 
can create your own unit and supply a conversion factor. You can only 
add a unit to a custom unit set.

To add a unit conversion:

1. From the list of Available Unit Sets, select the custom unit set to 
which you want to add the unit.

2. In the Display Units group, select the unit type you want to add a 
conversion.

3. Click the Add button. The User Conversion view appears as the 
figure below.

4. By default, the program names the new unit UserUnit*. You can 
change this name by entering a new name in the Name field.

5. In the second field (the multiply/divide field), type the conversion 
factor between your unit and the program’s internal unit. 

6. From the drop-down list, specify whether you want to multiply or 
divide by the conversion factor.

7. In the final field (the add/subtract field), type the conversion factor 
between your unit and the program’s internal unit. To add a factor, 
specify a value in this field. To subtract, place a negative sign in front 
of the number (e.g., enter -2.0).

8. Click OK and the User Conversion view closes with this unit as the 
active unit for that unit type.

 Figure 5.10

The program’s internal unit is 
always displayed on the User 
Conversion view.
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Deleting a Unit Conversion

You can only delete user defined unit conversions. To delete a unit 
conversion:

1. From the list of Available Unit Sets, select the unit set you want to 
use for your simulation.

2. In the Displayed Units group, select a user-created unit you want to 
delete.

3. Click the Delete button. You will not be prompted to confirm the 
deletion of the unit. The unit returns to the program’s default unit.

Formats Page
On the Formats page you can specify how variable values are displayed.

There are three buttons located on the Formats page:

 Figure 5.11

Button Description

Formats Allows you to open the Real Format Editor view for the selected 
variable.

Reset Allows you to reset the format of the selected variable back to the 
program’s default setting.

Reset All Allows you to reset all the variable formats back to the program’s 
default setting.

You can also open the Real 
Format Editor view by double-
clicking on the format cell of a 
variable.
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Modifying Variable Formats

To modify the format of a variable:

1. From the list of Variable Formats, click the format cell of the variable 
to be modified. (To select more than one format at a time, hold 
down the CTRL key, and click each variable you want to select.)

2. Click the Format button to display the Real Format Editor view. The 
Real Format Editor view varies, depending on which radio button in 
the Format Specification group is selected.

3. Select the format you want to use for your variable.

4. Click the OK button to accept the changes and close the view.
Click the Cancel button to close the view without accepting any 
changes.

 Figure 5.12

Assigns the default 
format to the 
associated values.
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Real Format Editor View

The Real Format Editor view is used to change variables format in the 
program. The three different formats available are as follows: 

Radio Button Description

Exponential Displays the values in scientific notation. The number of significant 
digits appearing after the decimal point is set in the Significant 
Figure field. As an example:

• Entered or calculated value: 10000.5
• Significant Figure: 5 (includes the first whole digit)

• Final display: 1.0001e+04

Fixed Decimal 
Point

Displays the values in decimal notation. The number of whole digits 
and significant digits appearing after the decimal point are set in the 
Whole Digits and Decimal Digits fields. As an example:

• Entered or calculated value: 100.5
• Specify whole digits: 3
• Specify decimal digits: 2
• Final display: 100.50

If the entered or calculated value exceeds the specified whole digits, 
the program will display the value as an Exponential, with the sum of 
the specified whole and decimal digits being the number of 
significant figures.

If the Display sign if zero checkbox is checked, the program will 
display the sign of the number entered or calculated that has been 
rounded to zero.

Significant 
Figures

Displays the values in either decimal notation and scientific notation. 
The number of significant digits appearing after the decimal point is 
set in the Significant Figure field.

Example 1:
• Entered or calculated value: 100.5
• Significant Figure: 5
• Final display: 100.50

Example 2:
• Entered or calculated value: 10000.5
• Significant Figure: 5
• Final display: 1.0001e+04
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5.4.3  Reports Tab
The Reports tab contains four pages: Format / Layout, Text Format, 
Datasheets, and Company Info.

Format / Layout Page
The Format / Layout page provides options for formatting and 
specifying the appearance of your printed reports. 

 Figure 5.13

Object Description

Shading checkbox When checked, headers, footers, and titles are shaded.

Line Numbers checkbox When checked, line numbers are on the left side of the 
report.

Thick Borders checkbox When checked, report border lines are thicker than the 
other lines in the report.

Indicate User Specified 
checkbox

When checked, any user specified values in the 
Datasheet are indicated with an asterisk (*).

Start Datasheet on New 
Page checkbox

When checked, each Datasheet starts on a new page.

Empty Text field Specify what you want to display in the Datasheet when 
there is no value available. The default text is “---”.

Unit Set drop-down list Select the unit set you want your Datasheet to use. This 
gives you the option of printing Datasheets with different 
unit sets than your case. For example, your case may be 
in SI, but you require your report to be in Field units.
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Text Format Page
For reports printed in text format, the Text Format page allows you to 
specify some text formatting options. 

Page Margins group Set the margins of your page. The values are the distance 
in inches from the edge of the page.

Paper Size drop-down 
list

Select the size of paper you want to print on. The list 
contains all of the Microsoft defaults.

Orientation drop-down 
list

Select the orientation of the data on the paper. You have 
two options: Portrait or Landscape.

 Figure 5.14

Object Description

Use Delimiting By 
Default checkbox

Check this checkbox if you want the text file to always be 
delimited.

Title Description Visible 
checkbox

When checked, a title is added to the text file. The title 
includes the name of the object and the tabs that are 
included in the report.

Header Field Visible 
checkbox

When checked, a header is added to the text file. The 
header includes the company information and the date 
the report was created.

Footer Field Visible 
checkbox

When checked, a footer is added to the text file. The footer 
includes the program version and build number.

Fields Padded for 
Alignment checkbox

When checked, spaces are added between each field to 
align the fields.

Object Description
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Datasheets Page
The Datasheets page allows you to select which datablocks are to be 
included for each stream, unit operation, utility, and reaction report 
printout.

Modifying Datasheets

To modify the datasheets:

1. Select the datasheet type in the Datasheet Types tree.

2. Select the datablocks to be included or excluded in the Default 
Datablocks group.

Empty Text field Specify what you want to display in the Datasheet when 
there is no value available. The default text is blank.

Delimiter field Specify what you want to use as the delimiter in your text 
file. The default text is comma delimited (,).

 Figure 5.15

Object Description

Checks all the datablocks 
checkboxes for the 
selected Datasheet type.

Checks all unchecked datablocks 
checkboxes and unchecks all 
checked datablocks checkboxes for 
the selected Datasheet type.

Click on the “+” or “-” icons to 
expand or shrink the 
branches.
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Company Info Page
On the Company Info page, you can provide some information about 
your company, such as the company name, location, and logo.

To modify the company information:

1. In the Company Name field, type the company name that you want 
to display in the report header.

2. In the Company Location text editor, type the company location 
that you want to display in the report header.

3. To add a company logo, click the Select button. The Select Bitmap 
on Disk view appears. Browse to the location of your bitmap file 
(*.bmp).

4. Select the file you want to import and click the Open button.

 Figure 5.16

The program does not 
automatically resize a bitmap 
file to fit the logo box on this 
page. 

The maximum logo size that 
can be accommodated by the 
logo box is 6.55 cm wide by 
2.38 cm high.

The logo picture has to be in 
bitmap format.
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5.4.4  Files Tab
The Files tab contains two pages: Options and Locations.

Options Page
The Options page allows you to modify the preferences used when 
saving or opening a case. 

From the Select style for ‘File Open’ and ‘Save As’ dialogs group, click 
either the Win 95/NT common dialogs or the HYPROTECH file picker 
radio button. The HYPROTECH file picker displays custom The 
program’s open and save views that show the build in which the case 
was saved, and the case description (if one was added).

 Figure 5.17
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In the AutoRecovery Settings and Backups group, use the checkboxes to 
select the options you want to use. The following options are available:

Locations Page
On the Locations page, you can select and specify the default paths for 
saving and reading case files.

For example, the program is set to look in the Cases folder for any case 
files because the Case directory field contains the path “cases”. Leave the 
field blank if you do not want to use a default location for that option.

Object Description

Save AutoRecovery 
Cases Every

When checked, the program saves an auto recovery case 
every specified amount of time. Use the minutes field to specify 
the amount of time between every save. You can use the up 
and down arrows to increase and decrease the value of the 
field by one with each click, or you can enter a value directly in 
the field.

Save AutoRecovery 
Case While 
Integrating 
checkbox

When checked, the program saves an auto recovery case 
every time the integrator is run. This checkbox is only available 
when the Save AutoRecovery Cases Every checkbox is 
checked.

Number of Case 
Backups 
Automatically 
Maintained field

This field is used in conjunction with the Number of Case 
Backups Automatically Maintained. When the field is specified 
with a number, the program maintains the specified number of 
backups of each simulation, using the extension bk*. The 
newest backup is bk0, the next newest bk1, etc.

 Figure 5.18
5-22



Tools Menu Options 5-23
There are several important files whose default location is defined here: 
COMThermo Fluid Package, Heat Transfer Coefficient database, Utilities 
database, and Capital Cost index database. It is very important to note 
that these default files and their default file location will be used if no 
other file is specified or the file specified cannot be located.

Changing Component Databases

The program allows you to read component data from seven databases. 

• Hyprotech (default database provided with the program)
• API database
• DIPPR database
• PPDS database
• DDB database
• HYSIM user database
• PPD HYSIM database

To change the component database:

1. Select Tools-Preferences command from the menu bar to open the 
Session Preferences view.

2. Click the Files tab and go to the Locations page. 

3. Beside the PPDS database display cell, enter the names of the 
database files to be used and their locations.

4. Close the Session Preferences view, by clicking on the Close icon.

5. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

6. Do one of the following:

• Select the fluid package from the Available Fluid Packages list 
and click the Edit Fluid Package icon to open the Fluid Package 
view.

• Click the Add Fluid Package icon to open the Fluid Package 
view

7. Go to the Components tab in the Fluid Package view, and select the 
new component database file from the Database drop-down list.

Close icon

Edit Fluid Package icon

Add Fluid Package icon
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5.4.5  Resources Tab
The Resources tab contains five pages: Colours, Fonts, Icons, Cursors, 
and Sounds.

Colours Page
All the functions and screen displays in the program are set with a 
predefined colour scheme. However, you can make changes to this 
colour set and customize it to meet the specific needs of your 
simulation.

The following table contains a list and description of the objects in the 
Colours Page view:

 Figure 5.19

Object Description

Colour Name list Contains all the screen elements in the program for which you 
can change the colour.

Current Colour 
selector

Displays the current colour for the selected program element in 
the Colour Name list.

Select System 
Colour drop-down 
list

This drop-down list contains the colour system applied to the 
selected element in the Colour Name list.

Select Custom 
Colour button

Allows you to open the Colour Palette. The Colour Palette is 
used to select a different colour or supply a custom colour.

The program’s default colour 
settings for text in cells/fields 
are as follows:

• Black text indicates the 
value is calculated by 
the program and cannot 
be changed.

• Blue text indicates the 
value is entered by the 
user and you can 
change the value.

• Red text indicates the 
value is calculated by 
the program and you 
can change the value.

You can double-click in the 
Current Colour selector to 
open the Colour Palette.
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To change the colour of an element:

1. Select the item from the Colour Name list.

2. From the Select System Colour drop-down list, select one of the 
system colours that are available or select <Custom>. 

3. If you select <Custom>, click the Select Custom Colour button. The 
Colour Palette appears.

4. Select the colour you want from the Colour Palette or your own 
customize colour and click the OK button. 

5. Notice the selected item has changed from the default colour to the 
new colour you selected. You can continue to change whatever item 
colours you want.

Use 3D Look 
checkbox

Check or Uncheck this checkbox to toggle the 3-dimensional 
appearance of views when using Windows 2000/XP.

Reset All Colours 
button

Allows you to reset all element colours to the program’s default 
colour scheme.

 Figure 5.20

Object Description

If you change any colour 
settings and then want to 
return to the default program 
colours, click the Reset All 
Colours button.
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Fonts Page
All the text appearing in the program has a predefined font scheme. 
However, like the colour scheme, you are able to change the font 
scheme. The structure of the Fonts page is much like the Colours page, 
as shown in the figure below.

The following table contains a list and description of the objects on the 
Fonts page:

 Figure 5.21

Object Description

Font Name list Contains all the text items in Concept.

Current Font 
selector

Displays the current font for the selected item in the Font Name 
list.

Select System Font 
field

Displays the system font currently applied to the selected font. 
You can select another system font in the drop-down list.

Select Custom Font 
button

Allows you to open the Font view. 

You can also double-click in the Current Font selector to open 
the Font view. 

Test Scaling field This field is used for scaling the font in the Current Font field. 
The default display scale value is 1.0. You can change the 
number value in this field. Increasing the number increases the 
size of the font, and decreasing the number decreases the font 
size in the Current Font field.

Reset All Fonts 
button

Allows you to reset all fonts to the program’s default font 
scheme.

Refer to the Font View 
section for more information.
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Font View

The Font view allows you to change the font type, style, and size of the 
selected text item in the Font Name list on the Fonts page.

To change the font for a text item:

1. Select the text item in the Font Name list.

2. From the Select System Font drop-down list, select one of the 
system fonts that are available or select <Custom>.

3. If you selected <Custom>, click the Select Custom Font button. The 
Font view appears so you can select the font you want.

4. Click the OK button to return to the Preferences Fonts page. The 
new font appears in the Current Font field.

 Figure 5.22
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Icons Page
The program has a default icon scheme. Any icons in the program that 
you can change are displayed on the Icons page. The structure of the 
Icons page is the same as the Colours and Fonts pages.

The following table lists and describes the objects on the Icons page:

 Figure 5.23

Object Description

Icon Name list Contains all the icons that can be changed in Concept.

Current Icon 
selector

Displays the current icon for the selected item in the Icon Name list.

Select System 
Icon field

Displays the icon system applied to the selected item in the Icon 
Name list. You can change the icon system using the drop-down list.

Select Custom 
Icon button

Allows you to open the Internal Icon view.

You can also double-click on the Current Icon selector to open the 
Internal Icons view.

Test Alignment 
radio buttons

Allows you to align the icon. Select the radio button and the icon in 
the Current Icon field will move according to the radio button 
selected.

Reset All Icons 
button

Allows you to reset all Icons to the program’s default icon scheme.

Refer to the Internal Icons 
View section for more 
information.
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Internal Icons View

The Internal Icons view allows you to supply a custom icon or select  a 
different icon for the selected icon item in the Icon Name list on the 
Icons page.

To change an icon:

1. From the list of icon names, select the icon you want to modify.

2. From the Select System Icon drop-down list select one of the system 
icons that are available or select <Custom>. 

3. If you selected <Custom>, click the Select Custom Icon button. The 
Internal Icons view appears.

4. Scroll through the available icons or click the Browse button to find 
the icon you want. After you have selected the icon you want, click 
the OK button.
The Current Icon field displays the icon you have selected.

 Figure 5.24

The Internal Icons view 
displays all the icons available 
in Concept. You can select 
any of these icons as the icon 
for an item.

Lets you browse into 
other directories 
(besides Concept) and 
select icons.

Scroll Bar indicates 
that there are more 
icons in this view.
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Cursors Page
As with the Colours, Fonts, and Icons pages, the program allows you to 
customize the mouse pointers. Cursors type is often specific to certain 
functions. Any cursor types that you can change are displayed on the 
Cursors page.

The following table lists and describes the objects on the Cursors page:

 Figure 5.25

Object Description

Cursor Name 
list

Displays all the cursors available in Concept.

Current Cursor 
selector

Place the mouse pointer on this display field to display the current 
cursor for the selected item in the Cursor Name list.

Select System 
Cursor field

Displays the cursor system presently applied to the selected item in 
the Cursor Name list. You can change the cursor system using the 
drop-down list.

Select Custom 
Cursor button

Allows you to open the Internal Cursors view. 

You can also double-click in the Current Cursor selector to open the 
Internal Cursors view.

Use Tool Tips 
checkbox

When checked, certain objects in the view will display the tool tips 
when the mouse pointer hovers over the object. 

When unchecking the Use ToolTips checkbox, the Show ToolTips 
checkbox in the General tab will also be unchecked.

Reset All 
Cursors button

Allows you to reset all cursors to the program’s default cursor 
scheme.

Refer to the Internal Cursors 
View section for more 
information.
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Internal Cursors View

The Internal Cursors view allows you to change the cursor for the 
selected cursor item in the Cursor Name list on the Cursors page.

To change a cursor:

1. From the list of cursor names, select the cursor you want to modify.

2. From the Select System Cursor drop-down list, select one of the 
system cursors that are available or select <Custom>.

3. If you selected <Custom>, click the Select Custom Cursor button. 
The Internal Cursors view appears so you can select the cursor you 
want.

4. After selecting the icon you want from the list on the Internal 
Cursors view, click the OK button.
The Current Cursor field will display the cursor you selected, if you 
placed the mouse pointer over the field.

 Figure 5.26
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6-2 Window Menu
6.1  Window Menu
The Window menu contains general Windows application functions. 
The options are: 

The last group of commands in this menu is a list of all open views on 
the desktop. The active view is indicated with a black checkmark.

 Figure 6.1

Command Description

Arrange Desktop Cascades all views which are currently open and not iconized.

Arrange Icons Arranges iconized views horizontally at the bottom of the 
desktop.

Close    CTRL+F4 Closes the active view.

Close All Closes all the views.

Save Workspace Allows you to save the current desktop layout for future use.

Load Workspace Allows you to load another case which is currently open. This 
function lets you toggle between cases.

Black checkmark
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6.1.1  Save Workspace
You can save different Workspace arrangements within a case. The 
Workspace is a specific organization of views for the current case. For 
example, you could create an arrangement of views which has the HI 
Case, Simple Column, Stream Workbook, Fluid Package Manager, etc. 
You can name each arrangement individually, then re-access the 
arrangement at any time.

This has no effect on the calculation status. It is simply the way the 
various views are arranged. After changes have been made to the 
desktop arrangement, you can then re-load a saved arrangement to re-
access the view layout.

To save a workspace:

1. Click on the Window menu.

2. Select the Save Workspace command. The Save Workspace view 
appears.

3. In the Save Workspace As field, enter the name of the workspace.

4. Click the Save button.
Click the Cancel button to close the Save Workspace view without 
saving the current workspace.

 Figure 6.2
6-3



6-4 Window Menu
6.1.2  Load Workspace
The Load Workspace view displays all cases that are currently open. The 
Workspaces contained within each case appear in the Available 
Workspaces group. 

To load a workspace:

1. Click on Window menu.

2. Select the Load Workspace command. The Load Workspace view 
appears.

3. From the list of available cases, select the case in which you are 
currently working.

4. From the list of available workspaces, select the workspace you want 
to use.

5. Click the Load button.
Click the Cancel button to close the Load Workspace view without 
making any changes to the current desktop.

To switch to another open case:

1. Select the Window-Load Workspace command from the menu bar. 
The Load Workspace view appears.

2. From the list of available cases, select the case in which you want to 
switch.

3. From the list of available workspaces, select the workspace you want 
to load in the new case.

4. Click the Load button.

 Figure 6.3

Check the Save when 
Switching checkbox to save 
the case when switching 
between workspaces.

Check the Save when 
Switching checkbox to save 
the case when switching 
between workspaces.
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6.2  Help Menu
The Help menu contains commands to help you use the Conceptual 
Engineering Suite programs. You can access the Help menu by doing 
one of the following:

• Move mouse pointer over the Help menu in the menu bar and click.
• Press ALT H.

The following commands are available in the Help menu:   

 Figure 6.4

Menu Option Description

Contents Displays the online help contents.

Hyprotech on 
the Web

If there is an internet connection, this command will access 
Hyprotech’s web site using the user’s default browser.

Bug Report Opens the Bug Reports view. This view allows you to log in bugs 
and inform the program about the bugs.

About Provides information about the program.
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6.2.1  Adding a Bug Report
To add a bug report:

1. Open the Help menu and select Bug Reports command. The Bug 
Reports view appears.

2. Click the New button on the Bug Reports view, to display the Bug 
Report view.

3. In the Bug Title field, type the name of the bug report.

 Figure 6.5

 Figure 6.6
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4. The current date and time appear in the Date field, but you can 
change it if necessary.

5. In the Reported by field, type a contact name so Hyprotech 
Technical Support can ask further questions or provide answers to 
the problem.

6. In the Class group, select either the Bug or Enhancement radio 
button.

7. In the Priority group, select either the High, Medium or Low radio 
button.

8. In the Program Area field, enter the area of the program in which the 
bug is found. For example, if a bug is found on the Plots tab of the 
Phase Equilibrium view, specify Plots tab - Phase Equilibrium 
operation. Be as specific as possible so the problem can be located.

9. In the Step-by-Step Description text editor, enter the steps used to 
produce the bug. Be as specific as possible so the problem can be 
located and fixed.

10. In the Reproducibility group, click either the Always, Sometimes, or 
Never radio button.

11. Click the Write button to display the Save File view.

12. Specify a name and location for your bug report file.

13. Click the Save button.

14. E-mail the bug report file to the AspenTech Support Center at 
esupport@aspentech.com.

6.2.2  Editing a Bug Report
To edit a bug report:

1. Open the Help menu and select Bug Reports command. The Bug 
Reports view appears.

2. From the list of available bug reports, select the bug report you want 
edit.

3. Click the Edit button to display the Bug Report view.

4. From this view, modify any of the parameters making up the bug 
report.
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6.2.3  Deleting a Bug Report
To delete a bug report:

1. Open the Help menu and click Bug Reports. The Bug Reports view 
appears.

2. From the list of available bug reports, select the bug report you want 
delete.

3. Click the Delete button.

You will not be prompted to confirm the deletion of a bug report, so 
ensure the correct report is selected before deleting.
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7-2 Object Inspect Menu
7.1  Object Inspect Menu
In the program, there are a number of instances in which either the 
mouse or the keyboard can be used. You can perform many of the tasks 
and manipulations by using the Object Inspect menu. Place the mouse 
pointer over the object you want to inspect and right-click to open the 
Object Inspect menu of the object. Different Object Inspect menus 
appear depending upon the object selected (i.e., Stream, Plot, 
Operation, etc.).

7.2  Empty Area in a View
If you right-click an empty space in a view containing a table and tabs or 
pages, an Object Inspect menu similar to the one displayed on the left 
appears. 

7.3  Text Editor
When you right-click in the text editor, the Object Inspect menu displays 
two commands.

Object Inspect menu

Command Description

Print Datasheet Lists the available Datasheets for the currently active object. You 
can highlight a Datasheet and either preview or print it. Refer to 
Section 3.7 - Print Commands for more details.

Open Page Opens a new view that displays only the active page information. 
The Open Page command is not available in all Object Inspect 
menus. 

Object Inspect menu
Command Description

Print Text Prints the text inside the text area.

Printer Setup Accesses the typical Windows Print Setup, which allows you to 
select the printer, the paper orientation, the paper size and paper 
source.
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7.4  Plot Area
When you right-click inside a plot, the type of Object Inspect menu that 
appears will depend on the number of independent variables the plot 
displays. 

7.4.1  Two Axes Plots
Two Axes plots have two independent variables. The two axes plots in 
the program include: any plots associated to HI Case and HI Project, 
Binary Plots, McCabe-Thiele Plots, Omega Plots, and Bifurcation Plots. If 
you right-click a two axes plot, the Object Inspect menu appears similar 
to the figure on the left.

The following table lists and describes the commands available on the 
Object Inspect menu.Object Inspect menu

Command Description

Graph Control Opens the Graph Control view. For more information, 
refer to Section 8.2 - Graph Control View.

Cross Hair Toggles the Cross Hair option on or off.

Vertical Cross Hair Toggles the Vertical Cross Hair option on or off.

Horizontal Cross Hair Toggles the Horizontal Cross Hair option on or off.

Values Toggles the Display Values option on or off. For more 
information, refer to Section 8.3 - Values.

Copy to Clipboard Copy the entire plot into the clipboard. For more 
information, refer to Section 8.4 - Copy to Clipboard.

Print Plot Prints the plot as it appears on the screen. For more 
information, refer to Section 8.5 - Print Plot.

Printer Setup Accesses the typical Windows Print Setup, which allows 
you to select the printer, the paper orientation, the paper 
size and paper source.
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7.4.2  Triangle Plots
Triangle plots have three independent variables. The triangle plots in 
the program include: Ternary Plots, Component Space Plots, and RCM 
Plots and Sketches. If you right-click a Component Space plot, the 
Object Inspect menu appears similar to the figure on the left.

Depending on the plot, none or one of the two following commands 
may appear above the Plot Orientation command.

• Calculate. Performs all calculations and updates the plot. Available 
only on RCM Plots.

• Show Entire Profiles/Show Profiles to Intersection. Show 
stripping, rectifying, and intermediate profiles until they reach a 
pinch point or until they intersect. Available only on Component 
Space Plots.

The following table lists and describes the rest of the commands 
available on the Object Inspect menu.

Object Inspect menu

Command Description

Plot Orientation Opens the Plot Orientation view. For more information, refer to 
Section 8.6 - Plot Orientation View.

Graph Control Opens the Graph Control view. For more information, refer to 
Section 8.2 - Graph Control View.

Zoom Out Zooms display out by 25%.

Values Toggles on or off the fly by displaying pointed curve coordinates. For 
more information, refer to Section 8.3 - Values.

Equilateral/
Right Angle

Toggles the type of triangle plot displayed as Equilateral or Right 
Angle.

Copy to 
Clipboard

Copy the entire plot into the clipboard. For more information, refer to 
Section 8.4 - Copy to Clipboard.

Print Plot Prints the plot as it appears on the screen. For more information, 
refer to Section 8.5 - Print Plot.

Printer Setup Accesses the typical Windows Print Setup, which allows you to 
select the printer, the paper orientation, the paper size and paper 
source.
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7.4.3  Quaternary Plots
Quaternary plots have four independent variables. A four-component 
RCM plot in the program is an example of a quaternary plot. If you right-
click a quaternary plot, the Object Inspect menu appears similar to the 
figure on the left.  

The commands in the following table apply to the quaternary plot of the 
Property Table operation:

Command Description

Rotation Toggles on or off the rotation control of the plot. 

When the rotation control is enabled, you can manipulate the angle 
of the displayed quaternary plot by clicking and dragging the mouse 
pointer within the plot or pressing the arrow keys.

Border Toggles on or off the border of the quaternary plot.

Lines Toggles on or off the residue curves in the quaternary plot.

Trace Toggles whether the X-Y, Y-Z, and X-Z planes appear near the 
quaternary plot.

Values Toggles on or off the fly by displaying pointed curve coordinates. For 
more information, refer to Section 8.3 - Values.

Copy To 
Clipboard

Copy the entire plot into the clipboard. For more information, refer to 
Section 8.4 - Copy to Clipboard.

Print Plot Prints the plot as it appears on the screen. For more information, 
refer to Section 8.5 - Print Plot.

Printer Setup Accesses the typical Windows Print Setup, which allows you to 
select the printer, the paper orientation, the paper size and paper 
source.

Command Description

Graph Control Opens the Graph Control view. For more information, refer to 
Section 8.2 - Graph Control View.

Colour Control Opens the Colour Editor view. For more information, refer to the 
Colour Editor View section.

Show Plane Opens the View view. The View view contains a binary plot of an 
active plane cut (indicated by thick black plot line). If there is no 
active plane cut on the plot, the binary plot appears blank.

Plane Cutting Toggles on or off the plane cutting option. 

When the plane cutting option is on, you can cut a plane by clicking 
and dragging from the edge of the X or Y or Z axis to where you 
want the plane cut to occur. The active plane cut is indicated by thick 
black plot line.

Hidden Lines Toggles between showing or hiding the surface of the plot.

When the hidden lines option is on, the surface of the plot is visible. 
So you cannot see the back lines (back surface) of the plot until you 
rotate the plot to a different angle.

Object Inspect menu

Object Inspect menu
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Colour Editor View
The Colour Control command from the Object Inspect menu of the 
Property Table quaternary plot, opens the Colour Editor view. 

The Colour Editor view contains options to manipulate the colour of the 
plot lines displayed on the graph. You can select the colour for the 
dependant variable plot line within a range of values.

 Figure 7.1

 Figure 7.2

Object Inspect menu

As shown in the plot 
on the left. The 
dependent value is 
temperature, and the 
plot line colour varies 
within certain 
temperature range. 
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The following table lists and describes the objects available in the 
Colour Editor view:

Object Description

Range cell Displays the designated number for the different colour range. 
You can have up to five different colour range.

Min cell Allows you to specify the minimum value when the selected 
colour should appear on the plot.

Max cell Allows you to specify the maximum value when the selected 
colour should appear on the plot.

Colour cell Allows you to select the colour that will appear for the selected 
value range.

To change the colour of a value range:

1. Double-click in the Colour cell. The Colour Palette appears.

2. Select the colour you want from the Colour Palette or your 
own customize colour and click the OK button.

Active checkbox Allows you to toggle on or off the selected colour in the plot for 
the specified range.

Enable Range 
Colouring checkbox

Allows you to toggle on or off the different colour of the 
specified value range.

If the checkbox is unchecked, the plot lines on the graph is blue 
in colour.

If the checkbox is checked, the plot lines on the graph displays 
the colour of the specified value range.

Apply button Allows you to apply any changes you make on the Colour 
Editor view to the current plot.

Clear button Allows you to clear all the options/selections in the Data Range 
Colouring group.

Reset button Allows you to reset all the options/selections in the Data Range 
Colouring group to the program default selections.

When the checkbox is 
checked, the selected colour 
for the specified range 
appears on the plot line.

When the checkbox is 
unchecked, the plot line is red 
in colour for the specified 
range.
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7.5  Project View
In any project view, there are three different panes and two or three 
different levels. Depending on the level, the pane, and the area on which 
you right-clicked, the Object Inspect menu will be different.

7.5.1  Viewer Pane
At any level, right-clicking in an empty space in the Viewer pane will 
open the Object Inspect menu shown on the left. An empty space of a 
view is defined as any area outside a list, text editor, plot, HEN diagram, 
or PFD. The following table contains a list and description of the 
commands in the Object Inspect menu.

Viewer Group
The Viewer group contains four different Object Inspect menu, 
depending on the active level and type of operation selected.

Command Description

Maximize Frame Maximizes the selected pane so that it is the only one visible in 
the project view. 

When viewing a maximized pane, you can still access the other 
two panes by clicking and dragging the double border now 
situated at the pane edges.

Open Frame Opens a new view that displays only the selected pane.

Reset Frame Restores the selected pane to default size.

You have to right-click within the Viewer group list to access these 
Object Inspect menus.

Object Inspect menu
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Project Level

For any operation at the project level, right-clicking in the Viewer group 
list opens the Object Inspect menu shown on the left. The commands in 
the menu are described in the table below. 

Scenario Level

There are three operations in the program that uses the project view: 
Column Sequencing, Azeotropic Column Sequencing, and HI Project.

Azeotropic Column Sequencing & Column Sequencing

For Azeotropic Column Sequencing and Column Sequencing 
operations, right-clicking in the Viewer group list opens the Object 
Inspect menu shown on the left. The commands in the menu are 
described in the table below.

HI Project

For the HI Project operation, right-clicking in the Viewer group list 
opens the Object Inspect menu shown on the left. The commands in the 
menu are described in the table below.

Command Description

Add a Scenario Adds a scenario under the selected project level.

Rename Project Renames the selected project

Command Description

Clone Scenario Clones the selected scenario.

Rename Scenario Renames the selected scenario.

Delete Scenario Deletes the selected scenario.

Command Description

Add Design Adds a design under the selected scenario.

Copy Scenario Data Allows you to select the data that you want to copy to an 
existing scenario. This is useful in copying only part of the input 
data to a newly created scenario.

Object Inspect menu

Object Inspect menu

Object Inspect menu
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Design Level

As mentioned before, there are three operations that uses the project 
view: Column Sequencing, Azeotropic Column Sequencing, and HI 
Project.

Azeotropic Column Sequencing & Column Sequencing

For Azeotropic Column Sequencing and Column Sequencing 
operations, right-clicking in the Viewer group list opens the Object 
Inspect menu shown on the left. The commands in the menu are 
described in the table below.

Clone Scenario Generates a complete copy of the selected scenario.

Delete Scenario Removes the selected scenario.

Rename Scenario Rename the selected scenario

Extract Data From 
HYSYS

Generates heat integration data from an existing case in 
HYSYS or Aspen Plus. For more information, refer to Chapter 
8 - Data Extraction from the Heat Integration manual.

Recommend Design Automatically generates a heat exchanger network from the 
scenario information. For more information, refer to Chapter 4 - 
Heat Integration Project from the Heat Integration manual.

Enter Retrofit Mode Allows you to take the selected scenario into Retrofit mode. For 
more information, refer to Chapter 5 - Retrofit Mode Heat 
Integration manual

Command Description

Delete Design Removes the selected design.

Clone Design Generates a copy of the selected design

Rename Design Renames the selected design

Optimize Column 
Pressures

Opens the Optimize Pressure view.

The Optimize Pressure view allows you to specify the 
pressure range and the maximum number of iterations for 
the optimize calculations. 

Command Description

Object Inspect menu

Refer to Section 5.2.3 - 
Optimising Column 
Pressure from the Reference 
Guide for more information.
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HI Project

For the HI Project operation, right-clicking in the Viewer group list 
opens the Object Inspect menu shown on the left. The commands in the 
menu are described in the table below.

7.5.2  Worksheet Pane
At any level, right-clicking in an empty space in the Worksheet pane of 
the view will open an Object Inspect menu similar to the one shown on 
the left. An empty space of a view is defined as any area outside a list, 
text editor, plot, HEN diagram, or PFD.

The following table describes the commands available for the Worksheet 
pane Object Inspect menu.

Command Description

Delete Design Removes the selected design.

Clone Design Generates a copy of the selected design

Rename Design Renames the selected design

Enter Retrofit 
Mode

Allows you to take the selected scenario into Retrofit mode. For 
more information, refer to Chapter 5 - Retrofit Mode from the Heat 
Integration manual

Command Description

Print Datasheet Lists the available Datasheets for the currently active object. 
You can highlight a Datasheet and either preview or print it. 
Refer to Section 3.7.1 - Printing Datasheet for more details.

Maximize Frame Maximizes the selected pane so that it is the only one visible in 
the project view. 

When viewing a maximized pane, you can still access the other 
two panes by clicking and dragging the double border now 
situated at the pane edges.

Open Frame Opens a new view that displays only the selected pane.

Reset Frame Restores the selected pane to default size.

Open Page Opens a new view that displays only the active page/pane 
information.

Object Inspect menu

Object Inspect menu

For more information about 
pane, refer to Section 2.3.5 - 
Project View.

At Project level, the command 
Open Page is not available for 
the Object Inspect menu.
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7.5.3  Main Pane
At any level, right-clicking in an empty space in the Main pane of the 
view will open the Object Inspect menu shown on the left. An empty 
space of a view is defined as any area outside a list, text editor, plot, HEN 
diagram, or PFD. The following table contains a list and description of 
the commands in the Object Inspect menu.

7.6  PFD
The Column Sequencing view displays Process Flow Diagrams (PFD) of 
various feasible column sequences in the Main pane at the Design level. 
When you right-click on the PFD, the Object Inspect menu appears 
similar to the figure on the left.

Command Description

Print Datasheet Lists the available Datasheets for the currently active object. 
You can highlight a Datasheet and either preview or print it. 
Refer to Section 3.7.1 - Printing Datasheet for more details.

Maximize Frame Maximizes the selected pane so that it is the only one visible in 
the project view. 

Open Frame Opens a new view that displays only the selected pane.

Reset Frame Restores the selected pane to default size.

Object Inspect menu

When viewing a maximized 
pane, you can still access the 
other two panes by clicking 
and dragging the double 
border now situated at the 
pane edges.

Object Inspect menu

Command Description

Copy to Clipboard Copy the entire PFD view into the clipboard. For more 
information, refer to Section 8.4 - Copy to Clipboard.

Print Plot Prints the plot as it appears on the screen. For more 
information, refer to Section 8.5 - Print Plot

Printer Setup Accesses the typical Windows Print Setup, which allows you to 
select the printer, the paper orientation, the paper size and 
paper source.
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7.7  Grid Diagram
The heat exchanger network (HEN) design is graphically displayed in 
the Grid Diagram. The Grid Diagram is located in different areas for 
different operation:

• In HI Project operation: the HI Project view, Main pane at the Design 
level. 

• In HI Case operation: the HEN Design view, Grid Diagram tab. 

When you right-click the HEN design, the Object Inspect menu appears 
similar to the figure on the left.

The following table lists and describes the command available in the 
Object Inspect menu: 

Command Description

Zoom In Allows you to zoom in on the HEN design.

Zoom Out Allows you to zoom out on the HEN design.

Fit Both Allows you to fit the heat exchanger network on the HEN design in 
such a way that it fills the entire diagram area.

Fit Width Allows you to fit the heat exchanger network on the HEN design in 
such a way that it fills the width of the diagram area.

Switch Stream 
Direction

Allows you to toggle the direction of hot and cold streams in the HEN 
design.

Show/Hide 
Pinch Lines

Allows you to toggle the pinch lines to either be hidden or displayed 
on the HEN design.

Remove 
Markers

Allows you to remove any heat exchangers or splitters that have not 
been completely placed.

Show Loops Allows you to open a sub-menu that will contain a list of loops, if 
there is any, in the HEN design.

• To display a loop, open the sub-menu under the Show Loops 
command and select the loop you want to display.

• To hide the loop, open the sub-menu under the Show Loops 
command and select the None command.

Show Paths Allows you to open a sub-menu that will contain a list of paths, if 
there is any, in the HEN design.

• To display a path, open the sub-menu under the Show Loops 
command and select the path you want to display.

• To hide the path, open the sub-menu under the Show Loops 
command and select the None command.

Properties Allows you to open the Property Preset view. 

Select 
Configuration

Allows you to open the sub-menu that will contain a list of property 
presets. From the list, you can select a property preset that will 
change what is displayed on the HEN design. For more information, 
refer to Section 7.2.11 - Property Presets View from Heat 
Integration manual.

The Grid Diagram and its 
Object Inspect menus are 
only available in HX-Net.

Object Inspect menu

For more information, refer to 
Section 7.2.11 - Property 
Presets View from Heat 
Integration manual.
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7.7.1  Grid Diagram Objects
The Stream, Heat Exchanger, Splitter, and Branch objects in the HEN 
design has their own Object Inspect menu. The Object Inspect menu for 
each object is shown in the figure below. 

The following table lists and describes the commands available in the 
Object Inspect menus.

Edit 
Configuration

Allows you to open the sub-menu that will contain a list of property 
presets. From the list, you can select and edit any of the existing 
property presets. For more information, refer to Section 7.2.11 - 
Property Presets View from Heat Integration manual.

Clone 
Configuration

Allows you to open the sub-menu that will contain a list of property 
presets. From the list, you can select and clone an existing property 
preset. For more information, refer to Section 7.2.11 - Property 
Presets View from Heat Integration manual.

Copy to 
Clipboard

Allows you to copy the entire HEN design into the clipboard. For 
more information, refer to Section 8.4 - Copy to Clipboard.

Print Plot Allows you to print the plot as it appears on the screen. For more 
information, refer to Section 8.5 - Print Plot.

Print Setup Allows you to access the typical Windows Print Setup view. This 
view allows you to select the printer, the paper orientation, the paper 
size and paper source.

 Figure 7.3

Command Description

View Opens the object view.

Delete Removes the selected heat exchanger from the Grid Diagram.

Add Branch Adds another branch into the selected splitter on the Grid Diagram.

Delete Split Removes the selected splitter and heat exchangers on the selected 
splitter from the stream on the Grid Diagram.

Delete Branch Deletes the selected branch on a splitter in the Grid Diagram.

Command Description

Stream
Heat Exchanger 

Splitter Branch

Both View commands from 
the Splitter and Branch Object 
Inspect menu opens the Split 
Editor view.
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7.8  Operation Mode
The HI Case operation has two modes: Design and Operation. In 
Operation mode there are two features which are not available in Design 
mode: What If and Trend analysis.

The two operation modes and their Object Inspect menus are only 
available in HX-Net.

7.8.1  What If Analysis View
The What If feature allows you access to the What If Analysis view. This 
view is similar to the project view, except the view only contains two 
panes: Viewer and Results.

The following table lists and describes the Object Inspect menus 
available in the Viewer and/or Results pane:

Print Plot Prints the heat exchanger network as it appears on the screen. For 
more information, refer to Section 8.5 - Print Plot.

Print Setup Accesses the typical Windows Print Setup, which allows you to 
select the printer, the paper orientation, the paper size and paper 
source.

Command Description

Refer to Chapter 3 - 
Operations Mode from the 
Heat Integration manual for 
more information about the 
What If and Trend analysis 
features.

Refer to Section 2.3.5 - 
Project View for information 
about project views.

Object Inspect menu Command Description

Right-click in any blank 
area of the Viewer or 
Results pane to access 
this menu.

Print Datasheet Lists the available Datasheets for the currently active object. You 
can highlight a Datasheet and either preview or print it. Refer to 
Section 3.7.1 - Printing Datasheet for more details.

This command is only available for the Viewer pane.

Maximize 
Frame

Maximizes the selected pane so that it is the only one visible in the 
view. 

When viewing a maximized pane, you can still access the other two 
panes by clicking and dragging the double border now situated at 
the pane’s edges.

Open Frame Opens a new view that displays only the selected pane/tab.

Reset Frame Restores the selected pane to default size.

Open Page Opens the selected/active tab in a separate view.

This command is only available for the Results pane.
7-15



7-16 Operation Mode
7.8.2  Trend Analysis View
The Trend feature allows you access to the Trend Analysis view. This 
view is similar to the project view, except the view only contains two 
panes: Viewer and Results.

The following table lists and describes the Object Inspect menus 
available in the Viewer and/or Results pane:

Select an event type and 
right-click in the list to 
access this menu

Add Schedule Allows you to add an event to the What If analysis. You can have 
more than one event in the What If analysis.

Select an event and right-
click in the list to access 
this menu.

Add Task Allows you to add a task to the selected/active event. You can have 
more than one task in an event.

Delete Event Allows you to delete the selected event.

Execute Event Allows you to execute/perform the task(s) within the selected event.

Rename Event Allows you to rename the selected event.

Select a task and right-
click in the list to access 
this menu.

Delete Task Allows you to delete the selected task.

Object Inspect menu Command Description

Refer to Section 2.3.5 - 
Project View for information 
about project views.

Object Inspect menu Command Description

Right-click in any blank 
area of the Viewer or 
Results pane to access 
this menu.

Print Datasheet Lists the available Datasheets for the currently active object. You 
can highlight a Datasheet and either preview or print it. Refer to 
Section 3.7.1 - Printing Datasheet for more details.

This command is only available for the Viewer pane.

Maximize 
Frame

Maximizes the selected pane so that it is the only one visible in the 
view. 

When viewing a maximized pane, you can still access the other two 
panes by clicking and dragging the double border now situated at 
the pane’s edges.

Open Frame Opens a new view that displays only the selected pane/tab.

Reset Frame Restores the selected pane to default size.
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Select the summary level 
and right-click in the list to 
access this menu

Add Study Allows you to add a study to the Trend analysis. You can have more 
than one study in the Trend analysis.

Select a study and right-
click in the list to access 
this menu.

Change 
Throughput

Allows you to change the flow rate of all the streams simultaneously.

Clean 
Exchanger / 
Change 
Massflow

Allows you to add an event (cleaning a heat exchanger or change 
the mass flow rate of a stream) to the selected study. You can have 
more than one event in a study.

Delete Study Allows you to delete the selected study.

Execute Study Allows you to execute/perform the event(s) within the selected study.

Rename Study Allows you to rename the selected study.

Select an event and right-
click in the list to access 
this menu.

Delete Event Allows you to delete the selected event.

Object Inspect menu Command Description
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8-2 Introduction
8.1  Introduction
Many properties and results in this software can be viewed in graphical 
form. In order to customize your plot:

1. Right-click the plot area and the Object Inspect menu appears. 

The Object Inspect menu shown in the figure below belongs to a 
two-axes plot. If a plot has three- or four-axes, than the commands 
in the Object Inspect menu will vary.

2. Move the mouse pointer over the command you want to execute.

3. Click the highlighted command to select/execute the command you 
want to use to manipulate the plot.

The following commands are common for most plots:

• Graph Control
• Values
• Copy to Clipboard
• Print Plot
• Print Setup

 Figure 8.1

To access the Object Inspect 
menu:

1. Placed cursor over plot 
view.

2. Click the right mouse 
button.
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8.2  Graph Control View
The Graph Control command in the Object Inspect menu, opens the 
Graph Control view. The Graph Control view contains most of the 
options that allows you to modify the selected/active plot.

The figure below displays the Graph Control view that you will see if you 
open the Graph Control view of a two-axes plot

You can also open a specific tab on the Graph Control view. By double-
clicking in the plot area, you make the plot the active view. Then, either 
double-click on the plot title or on the legend to access the 
corresponding tabs in the Graph Control view.

While the plot area has focus, you can also click and drag on either the 
legend or title to reposition the selected item.

All changes made in the Graph Control view instantaneously affect the 
plot. There is no need to close the Graph Control view to see the 
modifications.

 Figure 8.2

The changes made to a plot using the Graph Control view are specific 
to the active plot. To make global changes, which will affect all plots, 
use the Colours and Fonts pages on the Resources tab of the Session 
Preferences view.

The Graph Control view is a 
modal view by default. To see 
the changes made to the plot, 
you can:

• Move the Graph Control 
view, so you can see the 
plot view.

• Change the Graph 
Control view to non-
modal view, and access 
the plot view.
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The options use to modify many of the plot characteristics, are 
categorized into the five tabs in the Graph Control view: Data, Axes, 
Title, Legend, and Plot Area

8.2.1  Data Tab
For each data set on the plot, you can:

• View the data set Type.
• Modify the data set Name.
• Specify the Colour and Symbol that represent the data on the plot.
• Choose a Line Style.
• Show/hide the Symbol or Line.
• Show/hide the name in the Legend.

Any changes that are made affect only the data set that is selected in the 
list.

To make modifications to the appearance of a data set:

1. Select the name of the data set from the list located at the left side of 
the Data tab. 

2. The information which corresponds to the selected data set appears 
in the fields, as shown in Figure 8.3.

The figure on the right is the Graph Control view of a two-axes plot. The 
figure on the left is the Graph Control view of a three-axes plot.

 Figure 8.3

This list contains all the data sets in the plot. 
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The following table lists and describes the objects in the Data tab view 
for both type of plots:

Object Description

Type Display field The program has two types of plot: Line or Bar. This field 
shows you which type of plot the data set is using. 

This field is only available for the two-axes plot.

Name field The name associated with the data set can be changed in this 
field. Changes made to the text in this field are reflected in the 
list of data sets and in the legend.

Colour selector Allows you to change the colour associated to the selected 
data set. To change the colour of the data set:

1. Double-click in the selector to open the Colour Palette. 

2. Select a colour from the default colour and click the OK 
button.

or 

3. Customize a colour by clicking the Define Custom Colours 
button and generating you customized colour. Then select 
your custom colour and click the OK button.

Symbol drop-down 
list

For two-axes plot, the Symbol drop-down list allows you to 
select the type of symbol you want associated to your data set.

To display the symbols along the plot line of the data set, you 
have to check the Visible checkbox. To hide the symbols, 
uncheck the Visible checkbox.

Symbol group For three-axes plot, the Symbol group contains the following 
objects:

• Style drop-down list. This drop-down list has the same 
function as the Symbol drop-down list from the two-axes 
plot.

• Scale field. This field allows you to modify the size of the 
symbol. There are only three sizes available, and they 
are represented by integer value between 1 to 3.

• Visible checkbox. This checkbox has the same function 
as the Visible checkbox from the two-axes plot.

Line Style drop-
down list

For two-axes plot, this drop-down list allows you to select the 
type of plot line you want associated to your data set.

To display the plot line of the data set, you have to check the 
Visible checkbox. To hide the plot line, uncheck the Visible 
checkbox.

Thickness field For two-axes plot, this field allows you to change the thickness 
of the plot line for the selected data set. Increasing the value in 
this field, increases the thickness. You can only enter integer 
values.

The colour of the text in this 
field is black, this indicates 
that it is a display field, you 
cannot change the information 
in this field.

The Symbol drop-down list is 
not available if the data set is 
type Bar.

The lowest thickness setting 
is 0 and the highest 
thickness setting is 5.
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8.2.2  Axes Tab
For each axis on the plot, you can:

• Change the label name, font, and units.
• Show/Hide the label name and/or units.
• Define the axis bounds or use the Auto Scale function.
• Format the axis values.
• Display the plot on a logarithmic axis

Any changes that are made will affect only the axis that is selected in the 
list.

To make modifications to the appearance of an axis:

1. Select the name of the axes in the list located at the left side of the 
Axes tab.

2. The information that corresponds to the selected axis appears in the 
fields, as shown in Figure 8.4.

Line group For three-axes plot, the Line group contains a Style drop-down 
list, a Thick field, and a Visible checkbox.

• Style drop-down list. This drop-down list has the same 
function as the Line Style drop-down list from the two-
axes plot.

• Thick field. This field has the same function as the 
Thickness field from the two-axes plot.

• Visible checkbox. This checkbox has the same function 
as the Visible checkbox from the two-axes plot.

Show in Legend 
checkbox

Allows you to toggle between displaying or hiding the data set 
name and plot line in the Legend.

Show Label 
checkbox

Allows you to toggle between displaying or hiding the data 
point value (boiling point temperature) on the plot/graph.

Object Description

The Show Label checkbox is 
only available for single point 
data on the plot, not for line 
data.

Refer to Section 5.4.2 - 
Variables Tab for information 
regarding value formatting.
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The figure on the right is the Graph Control view of a two-axes plot. The 
figure on the left is the Graph Control view of a three-axes plot.

The following table lists and describes the objects in the Axes tab for 
both plots:

 Figure 8.4

This list contains all the active axes in the plot. 

Object Description

Label group for two-
axes plot

This group contains the following objects:
• Label Field. This field allows you to change the label 

name for the selected axis.
To display the label name beside the axis, check the 
Visible checkbox beside the Label field. To hide the label 
name, uncheck the Visible checkbox.

• Label Drop-down list. This drop-down list contains all 
the possible units for the selected axis. You can select 
the units you want the selected axis to display.
To display the unit type beside the axis, check the Visible 
checkbox beside the Label drop-down list. To hide the 
unit type, uncheck the Visible checkbox.

• Label Font Selector. The font selector (located in the 
right side of the Label group) allows you to customize the 
font style and font size of the label. Double-click the font 
selector to open the Font view.

Label group for 
three-axes plot

This group contains the following objects:
• Side Field. This field has the same function as the Label 

field of the two-axes plot. The label appears along the 
axes.

• Vertex Field. This field allows you to modify the name 
associated with the selected axes. The name appears at 
the beginning of the axes.
To display the name at the beginning of the axis, check 
the Visible checkbox beside the Label field. To hide the 
label name, uncheck the Visible checkbox.

The Visible checkbox beside 
the Label drop-down list is 
only available if the Visible 
checkbox beside the Label 
field is checked.
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Bounds group The Bounds group is only available for the two-axes plot. There 
are two fields and their associated checkbox in this group: 
Minimum and Maximum.

Minimum:

There are two ways to set the minimum axis bound value in the 
Bounds group:

• Uncheck the Use Auto Scale checkbox beside the 
Minimum field, and enter the minimum value you want in 
the Minimum field.

• Check the Use Auto Scale checkbox beside the 
Minimum field to have the program automatically set the 
minimum bound value.

Maximum:

There are two ways to set the maximum axis bound value in 
the Bounds group:

• Uncheck the Use Auto Scale checkbox beside the 
Maximum field, and enter the maximum value you want in 
the Maximum field.

• Check the Use Auto Scale checkbox beside the 
Maximum field to have the program automatically set the 
maximum bound value.

Logarithmic Axis 
checkbox

Check this checkbox to display the selected axis on a 
Logarithmic scale. This checkbox is only available for the two-
axes plot.

Format field This display field allows you to modify the format of the 
selected axis values. Click the Ellipsis icon beside the Format 
display field to open Real Format Editor view.

Object Description

Ellipsis icon
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8.2.3  Title Tab
For the title on the plot, you can:

• Change the default title name and font.
• Select the colours for the Text, Background and Border of the title.
• Show/Hide the Title, Background and Border.

The figure on the right is the Graph Control view of a two-axes plot. The 
figure on the left is the Graph Control view of a three-axes plot.

The following table lists and describes the objects on the Title tab for 
both plots:

 Figure 8.5

Object Description

Text group The Text group contains the following objects:
• Text field. This field allows you to change the title of the plot.
• Visible checkbox. Check this checkbox to display the title on 

the plot. Uncheck this checkbox to hide the title.
• Colour selector. This colour selector allows you to change 

the title font colour. 

Font selector Allows you to customize the font style and font size of the title. 
Double-click the font selector to open the Font view.

The font selector is only 
available for the two-axes plot.
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To change the colour of the title text, title background, or title border:

1. Double-click in the colour selector, of the axes object you want to 
change, to open the Colour Palette.

2. Select a colour from the default colour and click the OK button

or 

3. Customize a colour by clicking the Define Custom Colours button, 
select and add you customized colours to the Custom colours 
palette. Then select your custom colour and click the OK button.

Background 
group

The Background group contains the following objects:
• Background colour selector. This colour selector allows you 

to change the title background colour. 
• Visible checkbox. Check this checkbox to display the 

selected background colour for the title on the plot. Uncheck 
this checkbox to hide the background colour.

Border group The Border group contains the following objects:
• Border colour selector. This colour selector allows you to 

change the title border colour. 
• Visible checkbox. Check this checkbox to display the border 

around the title on the plot. Uncheck this checkbox to hide the 
border.

 Figure 8.6

Object Description
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8.2.4  Legend Tab
For the legend on the plot, you can:

• Change the colour of the border, background, or text.
• Change the location of the legend on the plot area.
• Choose the orientation: vertical or horizontal.
• Show/Hide the border and background.
• Enable automatic resizing of the legend upon repositioning.

The figure on the right is the Graph Control view of a two-axes plot. The 
figure on the left is the Graph Control view of a three-axes plot.

The following table lists and describes the objects on the Legend tab:

 Figure 8.7

Object Description

Visible 
checkbox

Check the Visible checkbox to display the legend on the plot. 
Uncheck this checkbox to hide the legend.

Border group The Border group contains the following objects:
• Border colour selector. This colour selector allows you to 

change the legend border colour. 
• Visible checkbox. Check this checkbox to display the border 

around the legend on the plot. Uncheck this checkbox to hide 
the border.

Background 
group

The Background group contains the following objects:
• Background colour selector. This colour selector allows you 

to change the legend background colour. 
• Visible checkbox. Check this checkbox to display the 

selected background colour for the legend on the plot. 
Uncheck this checkbox to hide the background colour.
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To change the colour of the legend text, legend background, or legend 
border:

1. Double-click in the colour selector, of the axes object you want to 
change, to open the Colour Palette.

2. Select a colour from the default colour and click the OK button

or 

Customize a colour by clicking the Define Custom Colours button, 
select and add you customized colours to the Custom Colours palette. 
Then select your custom colour and click the OK button.

Text group The Text group contains the Text colour selector. This colour 
selector allows you to change the legend font colour. 

Font selector Allows you to customize the font style and font size in the legend. 
Double-click the font selector to open the Font view.

Alignment 
group

The Alignment group contains the following objects:
• Dynamic checkbox. Check this checkbox to have the 

program resize the legend when it is repositioned in the plot 
area.
For example, if the legend is placed near the view side where 
part of the information is cut off/hidden, the program 
automatically resizes the legend to display the cut off/hidden 
information.

• Vertical and Horizontal radio buttons. The two radio button 
allows you to set the orientation of the text in the legend. 
Select a radio button to position the legend information in a 
row or a column.

 Figure 8.8

Object Description

The font selector is only 
available for the two-axes plot.
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8.2.5  Plot Area Tab
For the area/background of the plot, you can:

• Change the colour of the Background, Frame, or Grid.
• Show/Hide the Background, Frame, or Grid.
• Change the colour of the Cross Hairs
• Show/Hide the Cross Hairs, or choose to display only the vertical or 

horizontal components.

The figure on the right is the Graph Control view of a two-axes plot. The 
figure on the left is the Graph Control view of a three-axes plot.

The following table lists and describes the objects on the Plot Area tab 
for both plots:

 Figure 8.9

Object Description

Background 
group

The Background group contains the following objects:
• Background colour selector. This colour selector allows you 

to change the plot background colour.
• Visible checkbox. Check this checkbox to display the 

selected background colour on the plot. Uncheck this 
checkbox to hide the background colour.

Grid group The Grid group contains the following objects:
• Grid colour selector. This colour selector allows you to 

change the grid colour in the plot. 
• Visible checkbox. Check this checkbox to display the grid in 

the plot. Uncheck this checkbox to hide the grid.
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Frame group The Frame group is only available for the two-axes plot. This group 
contains the following objects:

• Frame colour selector. This colour selector allows you to 
change the frame colour of the plot.

• Visible checkbox. Check this checkbox to display the frame 
around on the plot. Uncheck this checkbox to hide the frame.

Cross Hairs 
group

The Cross Hairs group is only available for the two-axes plot. This 
group contains the following objects:

• Cross Hairs colour selector. This colour selector allows you 
to change the cross hair colour on the plot. 

• Visible checkbox. Check this checkbox to display the cross 
hair whenever you place the cursor anywhere in the plot area. 
Uncheck this checkbox to hide the cross hair.

• Vertical Component checkbox. Check this checkbox to 
display the vertical cross hair. Uncheck this checkbox to hide 
the vertical cross hair.

• Horizontal Component checkbox. Check this checkbox to 
display the horizontal cross hair. Uncheck this checkbox to 
hide the horizontal cross hair.

Triangle Style 
group

The Triangle Style group is only available for the three-axes plot. 
This group contains two radio buttons: Right Angle and Equilateral.

Display the form of triangle plot you want to see by selecting one of 
the two radio buttons.

Object Description

The Visible checkbox is 
automatically checked when 
either Vertical Component or 
Horizontal Component 
checkbox is checked.

The Visible checkbox is 
automatically unchecked 
when both Vertical 
Component and Horizontal 
Component checkbox are 
unchecked.

A display field, that shows the cursor coordinate / axes values, appears at the bottom 
left corner of the plot view, when the Visible checkbox is checked in the Cross Hairs 
group.
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To change the colour of the plot background, plot grid, plot frame, or 
plot cross hair:

1. Double-click in the colour selector, of the axes object you want to 
change, to open the Colour Palette.

2. Select a colour from the default colour and click the OK button

or 

Customize a colour by clicking the Define Custom Colours button, 
select and add you customized colours to the Custom Colours palette. 
Then select your custom colour and click the OK button.

 Figure 8.10
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8.3  Values
You can toggle the Values command from the Object Inspect menu on or 
off. A checkmark appears on the left side of the Values command in the 
Object Inspect menu, when the command is on. The left side of the 
Values command in the Object Inspect menu is blank, when the 
command is off. See figure below:

When the Values command is on, you can place the cursor on a plotted 
point in the plot area and a fly by of values (or coordinates) will appear.

 Figure 8.11

 Figure 8.12

Command On Command Off
8-16



Plot Properties 8-17
8.4  Copy to Clipboard
Copy the area, plot, or PFD where the Object Inspect menu was 
accessed, and placed that image into the clipboard. The image can be 
taken and pasted into other programs as an image file, like a word 
processor.

The Copy to Clipboard command opens a sub-menu that contains four 
scale commands, shown in the figure below.

The scale commands let you decide how large an image you want to 
copy into the clipboard. The four scale commands are: 50%, 100%, 200% 
and custom scale.

To copy a customize scale of the view/area:

1. Right-click in the area to access the Object Inspect menu.

2. Select Copy To Clipboard command to open the sub-menu. 

3. In the Copy To Clipboard sub-menu, select Custom Scale 
command. The Copy Pane to Clipboard view appears.

4. Enter the scale you want in the Copy at scale field. 

5. Click the OK button when you are finish, or click the Close icon to 
exit without copying anything to the clipboard.

 Figure 8.13

 Figure 8.14

Click the Up or Down arrow 
icons to increase or decrease 
the scale value.

Close icon
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8.5  Print Plot
There are two methods to print the plots in the program:

• Right-click the plot area to open the Object Inspect menu. Select the 
Print Plot command from the Object Inspect menu as shown in the 
figure below. This method prints only the plot as it appears on the 
screen.

or

• Select the plot view you want to print, then click the File menu and 
select the Print Snapshot command. This method prints the plot 
along with everything else in the view that has focus.For more 
information about printing in general, refer to Section 3.7 - Print 
Commands.

8.5.1  Print Setup
The Print Setup option accesses the typical Windows Print Setup, which 
allows you to select the printer, the paper orientation, the paper size, 
and the paper source. There are two methods to open the Print Setup 
view:

• Right-click the plot area to open the Object Inspect menu. Select the 
Print Setup command from the Object Inspect menu.

or

• Click the File menu and select Print Setup.

The Print Setup view will vary for different printers.
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8.6  Plot Orientation View
The Plot Orientation command from the Object Inspect menu opens the 
Plot Orientation view. 

The following table lists and describes the icons in the Plot Orientation 
view:

 Figure 8.15

Icons Description

Allows you to rotate the positions of the 
variables of the plot by one step counter 
clockwise. 

Allows you to switch the position of the two 
variables between the icon.

Allows you to rotate the positions of the 
variables of the plot by one step clockwise. 

Object Inspect menu

Depending on the type of triangle plot, the Plot Orientation view will vary between 
Right Angle (as shown on the left) and Equilateral (as shown on the right).
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9-2 Introduction
9.1  Introduction
All necessary information pertaining to flash and physical property 
calculations is contained within the fluid package. This allows you to 
define all the required information within a single entity. There are two 
key advantages to this approach:

• All associated information is defined in a single location, allowing 
easy creation and modification of the information.

• Multiple fluid packages can be used in the same simulation, 
however, they are all defined within the Fluid Package Manager.

In the program, most of the operations require a fluid package. 
Depending on the license that you bought, you may or may not have 
operations requiring a fluid package. The following is a list of operations 
that require a fluid package:

• Stream Manager
• Phase Equilibrium
• Property Table
• Pure Component Regression
• Fluid Phase Regression
• Simple Column
• Three Product System
• Complex Column
• Azeotropic Analysis
• Residue Curve Map
• Column Design
• Azeotropic Column Sequencing
• Column Sequencing
• Split Generator

The Fluid Package Manager 
may or may not be available 
to you, depending on the 
license program package you 
bought.
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9.2  Fluid Package Manager View
The Fluid Package Manager view allows you to manipulate and organize 
multiple fluid packages.

To access the Fluid Package Manager view, do one of the following:

• Click the Fluid Package Manager icon in the toolbar.
• From the Managers menu, select the Fluid Package Manager 

command.

The Fluid Package Manager view is divided into two groups: Available 
Fluid Packages and Fluid Package Information.

 Figure 9.1

Fluid Package Manager icon
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Available Fluid Packages Group
The following table lists and describes the objects available in the 
Available Fluid Packages group:

Fluid Package Information Group
The Fluid Package Information group contains a field and a text editor:

• Name field. Allows you to edit the name of the selected fluid 
package in the Available Fluid Packages list.

• Description text editor. Allows you to enter and store information 
about the selected fluid package in the Available Fluid Packages list.
The information in the Description text editor can also be entered in 
the Notes tab of the Fluid Package view.

Object Icon Description

Available Fluid 
Packages list

Contains all the fluid packages available in the 
current case.

The name, number of components, and property 
package of each fluid package appear in this list.

Add Fluid Package 
icon

Allows you to create a fluid package. Refer to 
Section 9.2.1 - Adding a Fluid Package for more 
information.

Edit Fluid Package 
icon

Allows you to edit the selected fluid package. Refer 
to Section 9.2.3 - Editing a Fluid Package for more 
information.

Delete Fluid 
Package icon

Allows you to delete the selected fluid package. 
Refer to Section 9.2.2 - Deleting a Fluid Package 
for more information.

Export Fluid 
Package icon

Allows you to export the selected fluid package as an 
*.ctf file. Refer to Section 9.2.4 - Exporting a Fluid 
Package for more information.

Import Fluid 
Package icon

Allows you to import a fluid package. Refer to 
Section 9.2.5 - Importing a Fluid Package for more 
information.

Export Fluid 
Package to HYSYS 
icon

Allows you to export the selected fluid package 
directly to a new HYSYS case. Refer to Section 
9.2.6 - Exporting Fluid Package to HYSYS for 
more information.

Default Fluid 
Package drop-down 
list

Allows you to designate the default fluid package for 
the current case.

To select a default fluid package, click the down 
arrow to open the drop-down list, then select the fluid 
package you want as the default.

When there are no fluid 
packages in the Available 
Fluid Packages list, only the 
Add Fluid Package icon and 
Import Fluid Package icon 
are available.

The fluid package can be 
directly exported only to 
HYSYS version 3.0 or higher.

If no fluid package is selected 
as the default, the program 
automatically selects the first 
fluid package in the Available 
Fluid Packages list as the 
default fluid package.
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9.2.1  Adding a Fluid Package
To add a fluid package:

1. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

2. Click the Add Fluid Package icon in the Available Fluid Packages 
group. The Fluid Package view appears.

3. In the Fluid Package view, click the Property Package tab and select 
the property package you want to associate with the fluid package. 
You can also select components and manipulate the binary 
coefficients and flash calculations in the Fluid Package view. 

4. When you have completed creating the fluid package, close the view 
by doing one of the following:

• Press CTRL F4.
• Click the Close icon, located at the top right corner.
• Double-click the Operation icon, located at the top left corner.

The new fluid package appears in the Available Fluid Packages 
group with a default name of Fluid1.

5. You can change the name of the fluid package by entering a new 
name in the Name field of the Fluid Package Information group.

The name of the selected fluid package appears in the title bar of the 
Fluid Package view and indicates which fluid package you are working 
on. You can have multiple Fluid Package views open and still know 
which fluid package you are manipulating.

Fluid Package Manager icon

Add Fluid Package icon

Refer to Section 9.3 - Fluid 
Package View for more 
information.

Close icon

Operation icon
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9.2.2  Deleting a Fluid Package
To delete a fluid package:

1. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

2. Select the fluid package you want to delete from the list in the 
Available Fluid Packages group.

3. Click the Delete Fluid Package icon in the Available Fluid Packages 
group. The program will prompt you to confirm that you want to 
delete the fluid package.

4. Click the Yes button.
If the deleted fluid package was the default fluid package, the 
program automatically selects the top first fluid package in the 
Available Fluid Packages list as the new default fluid package.

 Figure 9.2

Fluid Package Manager icon

Delete Fluid Package icon
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9.2.3  Editing a Fluid Package
To edit a fluid package:

1. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

2. From the Available Fluid Packages group list, select the fluid package 
you want to edit.

3. Click the Edit Fluid Package icon. The Fluid Package view for the 
selected fluid package appears.

4. Edit the fluid package using the options available on the various 
tabs in the Fluid Package view.

5. When you have completed editing the fluid package, close the view 
by doing one of the following:

• Press CTRL F4.
• Click the Close icon, located at the top right corner.
• Double-click the Operation icon, located at the top left corner.

The name of the selected fluid package appears in the title bar of the 
Fluid Package view and indicates which fluid package you are working 
on. You can have multiple Fluid Package views open and still know 
which fluid package you are manipulating.

Fluid Package Manager icon

Edit Fluid Package icon

Refer to Section 9.3 - Fluid 
Package View for more 
information.

Close icon

Operation icon
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9.2.4  Exporting a Fluid Package
To export a fluid package:

1. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

2. From the Available Fluid Packages group, select the fluid package 
you want to export.

3. Click the Export Fluid Package icon.
The Export Data as XML view appears.

4. Click the down arrow  in the Save in drop-down list and select 
where you want to save the exported fluid package.

5. In the File Name field, enter a name for the exported fluid package. 
The program will automatically attach the proper file extension 
(*.cft).

6. Click the Save button.

 Figure 9.3

Fluid Package Manager icon

Export Fluid Package icon
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9.2.5  Importing a Fluid Package
To import a fluid package:

1. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

2. Click the Import Fluid Package icon in the Available Fluid Packages 
group. The Import Data as XML view appears.

3. Find and select the fluid package file (*.ctf) you want to import.

4. Click the Open button.
The selected fluid package appears in the Fluid Package Manager 
view with the default name of ‘Fluid’ followed by a number.

9.2.6  Exporting Fluid Package to HYSYS
To export a fluid package to HYSYS version 3.0 or higher:

1. Open the Fluid Package Manager view by clicking the Fluid Package 
Manager icon.

2. From the list in the Available Fluid Packages group, select the fluid 
package you want to export.

3. Click the Export Fluid Package to HYSYS icon.
The HYSYS program will activate and a new case containing the 
selected fluid package from the program is automatically generated.

 Figure 9.4

Fluid Package Manager icon

Import Fluid Package icon

You can change the name of 
the selected fluid package by 
entering a new name in the 
Name field.

Fluid Package Manager icon

Export Fluid Package to 
HYSYS icon
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9.3  Fluid Package View
The Fluid Package view contains all the information/options required to 
generate a fluid package. To access a Fluid Package view, do one of the 
following:

• Open the Fluid Package Manager view by clicking the Fluid 
Package Manager icon, then click the Add Fluid Package icon.

• Open the Fluid Package Manager view by clicking the Fluid 
Package Manager icon, select the fluid package you want from the 
Available Fluid Packages list, and click the Edit Fluid Package icon.

The following table lists and describes the objects available in the Fluid 
Package view:

 Figure 9.5

Object Description

Property Package tab This tab allows you to select and manipulate the property 
package associated with the fluid package.

Components tab This tab allows you to add or create components 
associated with the fluid package.

Binary Coefficients tab This tab allows you to manipulate the binary interaction 
coefficient values between components in the fluid 
package.

Flash Control tab This tab allows you to manipulate the flash calculations 
performed for the fluid package.

Add Fluid Package icon

Edit Fluid Package icon The name of the selected fluid package appears in the title bar 
of the view and indicates which fluid package you are working 
on. You can have multiple Fluid Package view open and still 
know which fluid package you are manipulating.
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9.3.1  Property Package Tab
The Property Package tab is divided into two groups: Model Selection 
and Model Options.

Model Selection Group
The Model Selection group allows you to select a fluid phase and a 
property package for the fluid package. The Model Selection list 
contains the list of property packages associated with the selected fluid 
phase.

Model Options Group
The Model Options group allows you to manipulate the property 
package you select. When you select a property package, the Model 
Options table displays all the properties associated with the selected 
property package. Some properties can be manipulated by selecting a 
different option from the drop-down list in the property cell.

Notes tab This tab allows you to enter information about the fluid 
package.

Delete icon This icon allows you to delete the fluid package. The 
program will prompt you to confirm that you want to delete 
the fluid package.

Status Bar The status bar displays the selected property package 
associated with the fluid package.

Open Page Tab as 
Separate Window icon

This icon allows you to open an active tab as a separate 
view.

Object Description

Delete icon

Open Page Tab as Separate 
Window icon
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Selecting a Property Package
1. Open the Fluid Package view and click the Property Package tab.

2. In the Model Selection group, select the required phase for the 
property package by clicking the Vapour or Liquid radio button.

3. In the Model Selection list, find and select the property package you 
want to associate with the active phase.

After you select the property package, the Model Options table will 
be populated with properties for the selected property package.

4. Click the down arrow beside properties with red colour text in the 
Options column to view more options for the selected property.

For more information on calculating property options, refer to 
Chapter 7 - Property Packages of the COMThermo-Reference 
Guide.

 Figure 9.6

For more information on 
selecting property packages, 
refer to Section 3.1 - 
Equations of State and 
Section 3.2 - Activity 
Models of the COMThermo-
Reference Guide.
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9.3.2  Components Tab
The Components tab allows you to add, remove, edit, create, and clone 
components for the selected fluid package. You can choose from the 
components available in the program’s component library, or you can 
create your own hypothetical components.

The following table lists and describes the objects in the Components 
tab:

 Figure 9.7

Object Description

Selected Components 
list

Contains the names of the components that have been 
added to the fluid package.

Remove button Allows you to remove components from the fluid package.

Refer to the Removing Components section for more 
information.

View button Allows you to open the Component view(s) of the selected 
component(s) in the Selected Components list. 

For more information, refer to Section 9.4 - Component 
View.

Database drop-down list Allows you to select a different database file. Each 
database file contains different amounts and types of 
components. The default database is Hyprotech.

Match field Allows you to find the components you want by displaying 
a list of components that matches the text you entered in 
the Match field.

Show Synonyms 
checkbox

When checked, the program displays a list of 
components, including synonym names of the 
components, based on the text entered in the Match field.
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Search by Formula 
checkbox

When checked, the program displays a list of components 
based on the formula entered in the Match field.

Use Family Filter 
checkbox

When checked, the program displays a list of components 
based on the selected component family and the text 
entered in the Match field.

Family Filter button Allows you to access the Family Filter view. The Family 
Filter view contains the families into which the 
components are grouped.

For more information about the Family Filter view, refer to 
the Adding Components section.

Available Component 
List/Filter Options list

Displays a list of components depending on the text 
entered in the Match field, Show Synonyms checkbox, 
Search by Formula checkbox, and Use Family Filter 
checkbox.

If the Match field is empty, the list displays all the 
components.

Select button Allows you to add the selected component from the 
Available Component List/Filter Options list to the fluid 
package. Refer to the Adding Components section for 
more information.

Edit button Allows you to access the Component view(s) of the 
selected component(s). 

For more information, refer to the section Editing 
Components.

Create button Allows you to create a hypothetical component. Refer to 
the Creating Components section for more information.

Clone button Allows you to clone the selected component(s) from the 
Available Component List/Filter Options list. Refer to the 
Cloning Components section for more information.

Object Description

The components appear in 
ascending numerical and 
alphabetical order on the list.
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Adding Components
To add component(s):

1. Open the Fluid Package view and click the Components tab.

2. Search for the components you want from the Available Component 
List/Filter Options list by doing one or all of the following:

• Check the Show Synonyms checkbox to expand the list to 
include synonyms.

• Check the Search by Formula checkbox to filter the list by 
component formula.

• Check the Use Family Filter checkbox to filter the list by 
component families. Click the Family Filter button to open the 
Family Filter view. 
In the Family Filter view, check the checkboxes associated with 
the families you want the list to contain.

• Enter the name or formula of the component in the Match field.
• Scroll through the list using the scroll bar located at the right side 

of the list.
3. Select the components you want from the Available Component 

List/Filter Options list.

4. Click the Select button, or double-click the individual component to 
add it to the fluid package.
The selected components appear in the Selected Components list.

Removing Components
To remove component(s):

1. Open the Fluid Package view and click the Components tab.

2. In the Selected Components group, select the component(s) you 
want to remove.

3. Click the Remove button or press the DELETE key.

The All button checks all the 
checkboxes.

The Invert button checks all 
the unchecked checkboxes, 
and unchecks all the checked 
checkboxes.
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Creating Components
To create a component:

1. Open the Fluid Package view and click the Components tab.

2. Click the Create button in the Available Component List/Filter 
Options group. The Component view for the created/hypothetical 
component appears.

3. In the Name field, enter a name for the new component.

4. Enter all required information for the component in the property 
data fields.

5. When you are finished entering property data, click the Pure 1 tab 
and click the Estimate button that appears in the bottom right 
corner of the view.

6. Save the hypothetical component to the active database by clicking 
the Save button.

7. Click the Close icon to close the view.

 Figure 9.8

For easy identification, all created components are 
initially marked with a period (.) followed by a number 
and a plus sign (+) after the component name.

Refer to the Estimation 
Methods for Created 
Components section for the 
importance on clicking the 
Estimate button.

Close icon
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Cloning Components
To clone a component:

1. Open the Fluid Package view and click the Components tab.

2. Select the component you want to clone from the Available 
Component List/Filter Options list.

3. Click the Clone button. The Component view of the cloned 
component appears.

4. In the cloned component’s view, you can edit the name and 
properties of the cloned component. 
Refer to the Editing Components section for more information 
about editing components.

Editing Components
To edit a cloned or hypothetical component:

1. Open the Fluid Package view and click the Components tab.

2. Select the component you want to edit and open the Component 
view of the component by doing one of the following:

• Select the component from the Available Component List/Filter 
Options list and click the Edit button.

• Select the component from the Selected Components list and 
click the View button.

• Double-click the component from the Selected Components list.
3. Edit the component using the options available in the Component 

view. Refer to Section 9.4 - Component View for more information 
about the options available in the tabs.

The following components is treated differently than the rest of the 
components:

• Water
• Ethylene Glycol
• Triethylene Glycol
• Diethylene Glycol
• Ethanol

If these components are cloned, the cloned components will not have 
the special treatment.

For the purpose of 
identification, all cloned 
components are given the 
original component’s name, 
followed by a period (.), a 
number, and a plus sign (+).

The only instances in which 
you are allowed to edit in the 
Component view is when you 
clone a component or create a 
hypothetical component.
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4. When you are done editing the component, click the Close icon to 
close the Component view.

Estimation Methods for Created Components
The program currently supports the same standard estimation methods 
supported by COMThermo Workbench and HYSIM. It is very important 
that after you finish creating a new component, you click the Estimate 
button to finish estimating any fundamental pure component physical 
properties. If you do not do this, missing physical properties can result 
in incorrect calculations.

The following sequence lists the process used to determine which 
estimation methods will be used for any unknown Physical Properties:

1. If the component is not solid, hydrocarbon, or miscellaneous, a 
group contribution method will be used for Tc, Pc, Vc, enthalpies of 
formation, ideal gas, and Gibbs free energy. 

2. If only the normal boiling point is known, and the normal boiling 
point is < 150°F, the Bergman correlation is used for normal liquid 
density and molecular weight. If the normal boiling point is > 150°F, 
the Whitson correlation is used for normal liquid density and the 
Lee-Kesler correlation for molecular weight.

3. If the normal liquid density and molecular weight are known, a 
proprietary method for normal boiling point will be used.

4. If normal liquid density is > 1076 kg/m3, or normal boiling point is 
> 800 K, the Lee-Kesler correlation will be used for Tc, Pc and 
acentric factor.

5. If normal boiling point is < 548.15 K and normal liquid density is 
< 850 kg/m3, the Bergman correlation will be used for Tc, Pc and 
acentric factor.

6. In all other cases, Cavett will be used for Tc and Pc, and Edmister will 
be used for the acentric factor.

7. Cavett will be used for ideal gas enthalpies.

8. If the component is a Hydrocarbon, the Lee-Kesler correlation will 
be used for vapour pressures, and Twu for liquid viscosities.

9. In all other cases, Riedel will be used for vapour pressures and 
Letsou-Stiel for liquid viscosities.

10. Wsrk will be set equal to the acentric factor.

11. Vchar will be fitted to match the normal liquid density.

Close icon
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12. A proprietary correlation will be used for radius of gyration.

9.3.3  Binary Coefficients Tab
The Binary Coefficients tab allows you to manipulate the fluid 
behaviour coefficients between components based on the specified 
property package.

The following table lists and describes the objects in the Binary 
Coefficients tab:

 Figure 9.9

Object Description

Model drop-down list Allows you to select the model used to calculate the fluid 
behaviour. The models available will depend on the type 
of property package selected.

Coefficient drop-down 
list

Allows you to select different coefficient variables of the 
model to manipulate. The number of coefficient variables 
varies depending on the model selected.

Binary Interaction 
Coefficient matrix

Displays the binary interaction values of the selected 
coefficient variables associated with the selected models. 

Save button Allows you to save the binary coefficients for the selected 
components and property package for future use.

Unifac Estimate button Allows you to estimate missing coefficients.

For more information regarding 
the Binary Interaction 
Coefficient matrix, refer to the 
section Binary Interaction 
Coefficient Matrix.
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Binary Interaction Coefficient Matrix
The Binary Interaction Coefficient matrix is the basic tool for 
determining the fluid behaviour described by a specific property 
package.

The Binary Interaction Coefficients are determined as follows:

Estimation Methods

The options available in the Model and Coefficient drop-down lists on 
the Fluid Package view depend on the property package and 
components you select.

The program currently uses only the UNIFAC-VLE estimation method.

UNIFAC VLE

The UNIFAC correlation can be used to fill in or replace any of the binary 
values. When this option is selected, missing parameters are calculated 
using the UNIFAC FLE estimation method.

Method of 
Determination

Description

User Supplied To directly input any of the binary interaction coefficients into the 
Binary Interaction Coefficient Matrix, click in a cell and enter a value.

Unifac Estimate The program will estimate the binary interaction coefficients when 
you click the Unifac Estimate button. 

UNIFAC estimations are, by 
default, performed at 25oC.
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9.3.4  Flash Control Tab
The Flash Control tab allows you to manipulate the flash calculation 
parameters.

The Flash Control tab is divided into three groups: Stability Test 
Parameters, Calculation Parameters, and Search Parameters. Each group 
and the objects within the groups are described in the following 
sections.

The Reset All Control Parameters button allows you to reset all the 
values changed in the Flash Control tab to the program’s default 
settings.

 Figure 9.10
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Stability Test Parameters Group
The Stability Test Parameters group allows you to control how phase 
stability calculations are performed.

Phase Stability Test

For multi-phase fluids, there are multiple false solutions corresponding 
to the lower number of phases; for example, for a three-phase fluid, 
there is a three-phase solution, at least three two-phase solutions and 
multiple single-phase solutions. The major challenge is in converging to 
the right solution without prior knowledge of the number of equilibrium 
phases. 

If you encounter situations where the flash calculation fails or you are 
suspicious of the results, you can use the options in the Stability Test 
Parameters group to approach the solution using a different route. 
Unless there is strong evidence for three phases, a two-phase flash is 
first performed. The resulting phases are then tested for their stability.

Maximum Phases Cell

To specify the maximum number of phases allowed, enter a value in the 
Maximum Phases cell. If it is set to 2, the stability test will quit after a 
two-phase flash. Occasionally, you may still get three phases, as the 
algorithm might attempt to start directly with the three-phase flash.

If the true solution has two phases and the maximum phases allowed is 
set to 2, there is still no guarantee that the correct solution will be 
reached. For example, for binary mixtures around the azeotropic point, 
the correct solution might be liquid-liquid equilibrium, but the 
algorithm might incorrectly converge to vapour-liquid equilibrium.
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Stable Phase Criterion Cell

A phase’s stability is determined by solving for the distance between a 
tangent plane and the Gibbs energy surface. If the distance is positive at 
all points, the phase is stable.

The Stable Phase Criterion default value is 1x10-5. If your situation 
requires extreme consistency between the saturation calculation and 
the PT flash calculation, the criterion should be decreased accordingly. 
In this case, it is advisable to set the Additional Phase Search criterion to 
Extensive by clicking the appropriate radio button.

An iterative procedure is used in the phase calculations; a phase is 
generally considered stable if the distance is greater than a small 
negative number, , at all points. This is to avoid incorrectly introducing 
a second phase into the system.

If the fluid is very close to the phase boundary but inside the two-phase 
region, however, the ‘distance’ could be slightly negative for a very small 
region. If  is too large, the flash may mistake this fluid to be stable. 
This can be demonstrated by the following test: First, determine the 
bubble point temperature, Tb, of a normal fluid at a pressure of 1 atm 
(using the Stream Manager). Then, perform PT flash calculations at 
temperatures progressively closer to but higher than Tb. A single phase 
region will generally be predicted at a temperature slightly higher than 
the true bubble point temperature.

To correct for this, you can decrease the absolute value of the  
parameter. The lower limit is zero, where there is no provision for the 
tolerance of the stability equation. Consider the situation where the 
fluid is just outside the phase boundary. Since the stability equation is 
not solved to exactly zero, there is the possibility that the calculated 
distance is a very small negative value. With a zero  value, the flash will 
determine that the fluid is unstable. A second phase will then be 
introduced and redundant calculations will be performed until the 
introduced phase eventually disappears. Also, there is the possibility 
that this “false” phase will be re-introduced by the stability test.

δ

δ

δ

δ
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Thus, it is necessary to maintain a balance between accuracy and the 
efficiency of the flash calculation. The use of the default value should 
generally provide an accurate determination of the bubble point 
temperature to about 0.001oC.

Additional Phase Search Radio Buttons

The stability scheme used is that proposed by Michelsen (1982)100. To 
choose the method for performing the stability test calculations, click 
the appropriate radio button:

Radio Buttons Phase 

None No stability test will be performed.

Minimal The following methods are used: Deleted Phase, Wilson’s Equation 
and Component Initiation (Water). Only the water component (if it is 
part of the selected fluid package) is introduced.

Medium In addition to those methods used for the Minimal method, the 
Average of Existing and Ideal Gas methods are also included. As 
well, the heaviest and the lightest components in the fluid are 
introduced using the Component Initiation method.

Extensive All Phase Initiation methods will be utilized, and all components will 
be introduced using the Component Initiation method.
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Calculation Parameters Group
The Calculation Parameters group allows you to manipulate the 
iteration and tolerance settings of various calculation parameters. The 
options available in the Calculation Parameters group are divided into 
two tables: Iterations/Tolerance Settings and Search Accuracy.

Iterations/Tolerance Settings Table

The following table lists and describes the options available in the 
Iterations/Tolerance Settings table:

Search Accuracy Table

The following table lists and describes the options available in the 
Search Accuracy table: 

Cell Description

Max. Iterations Allows you to enter the maximum number of iterations executed in 
the flash calculations. When the algorithm reaches the maximum 
number of iterations, the calculations stop.

Error Allows you to enter a value for the error tolerance of the governing 
flash equilibrium equations. If the equilibrium equation error is less 
than the value in this cell, the flash algorithm is assumed to have 
converged.

Relative Error Allows you to enter a value for the relative error of tolerance 
between iterations. So, in addition to the above condition, if the 
change in the error between iterations is less than the value in this 
cell, the flash is assumed to have converged.

Trivial Comp. Allows you to enter a value for the trivial composition tolerance 
value. The trivial composition tolerance is used to detect 
convergence to the trivial solution (where the compositions in the 
two phases are identical). If the differences in the compositions of 
the two phases are all less than the value in this cell, the result is 
assumed to be trivial.

Cell Description

Temperature Allows you to enter a value for the tolerance in temperature during 
the secant temperature searches. It is used mainly by the backup 
flashes.

Pressure Allows you to enter a value for the tolerance in pressure during the 
secant pressure searches. It is used mainly by the backup flashes.

To avoid discarding azeotropic 
results, the compressibility (Z) 
factors for the two phases will 
be computed and compared 
in the case where the two 
phases involved are modeled 
using the same Property 
Methods (Equation of State 
Methods).
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Search Parameters Group
The Search Parameters group allows you to manipulate the secant 
temperature and pressure search options. These options are divided 
into two tables: Temperature and Pressure.

Temperature Table

The following table describes the options available in the Temperature 
table:.

To change the values, click in the appropriate table cell and enter the 
required value. From the drop-down list within the cell, select the 
appropriate temperature designation.

Pressure Table

The following table describes the options available in the Pressure table: 

Cell Description

Initial Val Allows you to enter a value for the initial temperature variable used 
during secant temperature searches. It is used mainly by the backup 
flashes.

Minimum Allows you to enter a value for the minimum temperature variable 
used during secant temperature searches. It is used mainly by the 
backup flashes.

Maximum Allows you to enter a value for the maximum temperature variable 
used during secant temperature searches. It is used mainly by the 
backup flashes.

Increment Allows you to enter a value for the increment variable used during 
secant temperature searches. It is used mainly by the backup 
flashes.

Cell Description

Initial Val Allows you to enter a value for the initial pressure variable used 
during secant temperature searches. It is used mainly by the backup 
flashes.

Minimum Allows you to enter a value for the minimum pressure variable used 
during secant temperature searches. It is used mainly by the backup 
flashes.

The default values in the 
Search Parameters group 
come from the COMThermo 
fluid package *.xml files.

Refer to the Locations Page 
section in Section 5.4.4 - 
Files Tab for information on 
location of the *.xml files.

The logarithm of Pressure is 
used as the primary variable 
for the pressure search, thus 
an initial Pressure Multiplier is 
required in place of a pressure 
increment.
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To change the pressure values, click in the appropriate cell and enter the 
required value.

9.3.5  Notes Tab
The Notes tab allows you to do the following:

• Change the name of the active fluid package by entering a new 
name in the Name field.

• Enter information regarding the fluid package by entering the 
information in the Notes text editor.

Maximum Allows you to enter a value for the maximum pressure variable used 
during secant temperature searches. It is used mainly by the backup 
flashes.

Multiplier Allows you to enter a value for the multiplier variable used during 
secant temperature searches. It is used mainly by the backup 
flashes. 

 Figure 9.11

Cell Description

The name in the Name field of 
the Notes tab will appear in 
the title bar of the Fluid 
Package view and the Name 
field of the Fluid Package 
Manager view.

The information in the Notes 
text editor of the Notes tab will 
appear in the Description text 
editor of the Fluid Package 
Manager view.
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9.4  Component View
The Component view displays the physical property data associated 
with a given component.

To access the Component view for any component:

1. Open the Fluid Package view of the fluid package that contains the 
particular component.

2. Select the Components tab.

3. Do one of the following:

• Select the required component from the Selected Components 
list and click the View button.

• Select the required component from the Available Component 
List/Filter Options list and click the Edit button.

The following table lists and describes the objects in the Component 
view:

 Figure 9.12

Object Description

ID tab Displays the property packages, various synonyms, and 
identification numbers associated with the component.

Temperature 
Dependent tab

Displays the temperature dependent properties in graph or 
table format.

Pure 1 and Pure 2 
tab

Displays the pure component properties in a table. 
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The following sections describe each tab in detail.

VLE tab Displays the Vapour Liquid Equilibrium pure component 
parameters in a table.

Solid tab Displays the pure component solid properties in a table, if the 
component has solid properties.

UNIFAC tab Displays the UNIFAC sub-groups associated with the 
component.

Notes tab Contains a text editor that allows you to enter information about 
the component. The component’s name appears in the Name 
field.

Save button Allows you to save the edited component in the active 
database.

Estimate button When clicked, the program estimates the missing property 
information for the edited component.

Open Page Tab as 
Separate Window 
icon

Allows you to open the active tab as a separate view.

Object Description

The Save and Estimate 
buttons are available only for 
cloned or hypothetical 
components.

Open Page Tab as Separate 
Window icon
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9.4.1  ID Tab
The ID tab allows you to make a number of changes to a cloned/
hypothetical component. 

• To edit the component name or formula, click in the Name or 
Chemical Formula field and enter the new name or formula.

• To edit the component’s association to the component family, click in 
the Family field and select a new family name from the drop-down 
list.

• To edit the ID numbers associated with the component, enter them 
in the various number identification fields. Unless you have reliable 
information, however, editing the ID numbers is not recommended.

• To change the property packages associated with the component, 
check or uncheck the checkboxes beside the property packages.

• To add another synonym to the component, click in the New 
Synonym field and enter the synonym.

 Figure 9.13

The text in the ID Number field 
is black, indicating that you 
cannot change the internal ID 
Number automatically 
assigned by the program.
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9.4.2  Temperature Dependent Tab
The Temperature Dependent tab allows you to change the type of 
equations and the coefficient values used to calculate the temperature 
dependent properties.

The following list describes the options available on this tab:

• To select which temperature dependent property you want to 
manipulate, click the first Temperature Dependent Property drop-
down list and select the required property.

• To edit the equation for the selected property, click the second 
Temperature Dependent Property drop-down list and select the 
required equation.

• To change the values of the coefficient used in the selected 
equation, click in the appropriate cell of the Coefficient table and 
enter new values.

• To change the temperature range for the calculation, click in the 
Minimum T and Maximum T cells and enter new values.

• To change the component basis displayed in the plot, click the 
Change Component Basis. The Basis Selection view appears.

On the Basis Selection view, switch between mass and molar 
fraction by clicking the appropriate radio button.

 Figure 9.14

 Figure 9.15

Displays the 
current Y and X 
shape type for 
the selected 
equation.

You can change the 
coefficient values used to 
calculate the properties by 
entering different values in 
the coefficient cells.

You can change the 
temperature range for the 
plot or the table by entering a 
different temperature value in 
the Minimum T and Maximum 
T fields.

Change Component Basis 
icon
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• To change the shape of the Y and X type in the selected equation, 
click the Mapping button. The Mapping view appears.

Use the Y Equation drop-down list to change the shape of the Y 
variable. Use the X Equation drop-down list to change the shape of 
the X variable.

• To change the view format for the calculated information, click the 
Normal, Log or Table radio button in the Display group.

9.4.3  Pure 1 and Pure 2 Tabs
The Pure 1 and Pure 2 tabs allow you to modify any of the properties 
displayed in the tabs.

 Figure 9.16

 Figure 9.17

Refer to Section 7.4 - Plot 
Area and Chapter 8 - Plot 
Properties for information on 
manipulating plots.

If the UNIFAC sub-group has 
been created or modified, a 
pure component property can 
be modified by:

1. Selecting the cell of a Pure 
1 or Pure 2 property, and 
pressing DELETE to delete 
the default value.

2. Clicking the Estimate 
button to calculate the new 
value of the property.
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In addition to editing the properties, you can also set the type of 
component in the Component Type group on the Pure 1 tab to Normal, 
Non-Condensable, or Non-Volatile.

9.4.4  VLE Tab
The VLE tab allows you to manipulate the values of the Vapour Liquid 
Equilibrium parameters.

 Figure 9.18

 Figure 9.19
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9.4.5  Solid Tab
The Solid tab allows you to manipulate the solid properties of the 
component.

9.4.6  UNIFAC Tab
The UNIFAC tab allows you to add and remove sub-groups from the 
UNIFAC structure.

 Figure 9.20

 Figure 9.21
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When you add or remove sub-groups:

• The UNIFAC-calculated properties (found in the Estimated 
Properties table) will automatically be updated based on the current 
structure.

• The base and critical properties will automatically be re-calculated 
using the current structure as predicted by UNIFAC

Adding Sub-Groups
To add sub-group(s), do one of the following:

• Select the Sub-Group. In the Available UNIFAC Sub-Groups list, 
use the scroll bars to find the sub-group you want. Select the sub-
group name and click the Add Sub-Group(s) button.
The sub-group appears in the Selected UNIFAC Sub-Groups table.

• Enter the Sub-Group Number. Each sub-group has a number 
associated with it. If you know the number of the sub-group you want 
to add, click in the <empty> cell of the Sub-Group column of the 
Selected UNIFAC Sub-Groups table and enter the sub-group 
number. 
In the Number column, enter the quantity required for the new sub-
group.

• Type in the Structure field. The Structure field, located near the 
bottom of the tab, lists all sub-groups already installed. To add a new 
sub-group, click the cursor after the last sub-group in the field and 
type the sub-group you want to install. The new sub-group appears 
in the Selected UNIFAC Sub-Groups table.
Example: If you want to add an OH group, type ‘OH’.

Deleting Sub-Groups
To delete sub-group(s), do one of the following:

• Click on the appropriate row of either the Sub-Group or Number 
column, and click the Delete Sub-Group button. The row/sub-group 
will be deleted.

• In the Structure field, select the sub-group(s) you want to remove, 
and press DELETE.

To avoid deleting existing sub-groups in the Structure field, ensure the 
existing entries are not selected before entering a new sub-group 
structure.

To select more than one sub-
group, use the SHIFT or CTRL 
key. This allows you to add 
all selected sub-groups to 
the UNIFAC structure at the 
same time.
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9.4.7  Notes Tab
The Notes tab allows you to do the following:

• Change the name of the hypothetical/cloned component by entering 
a new name in the Name field.

• Enter information regarding the hypothetical/cloned component by 
entering the information in the Notes text editor.

 Figure 9.22

The name in the Name field of 
the Notes tab will appear in 
the title bar of the Component 
view and the Name field of the 
ID tab.
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10-2 Capital Cost View
10.1  Capital Cost View
The Capital Cost view contains all the options required to manipulate 
the sizing and costing calculations for columns and heat exchangers. 

To access the Capital Cost view:

1. Open one of the following operations:
• Azeotropic Column Sequencing
• Simple Column
• Three Product System
• Complex Column
• Column Sequencing

2. Go to the Options tab/page.

3. Click the Capital Cost button. The Capital Cost view appears.

 Figure 10.1

The Capital Cost view is only 
available in DISTIL.

HX-Net has its own Capital 
Cost calculations located on 
the Economics tab/page.
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The Capital Cost view contains three objects at the bottom of the view 
that are available for all tabs. The following table lists and describes the 
three objects:

The Capital Cost view is divided into four tabs: Common, Column, Heat 
Exchanger, and Notes. The following sections describe each of the tabs 
in more detail.

10.1.1  Common Tab
The Common tab allows you to manipulate the variables used to 
calculate the total annual cost (TAC).

Object Description

Defaults button Allows you to reset all the sizing and costing variables to 
the program’s default values.

Hold checkbox Allows you to toggle between calculating and not 
calculating the size and cost for the current operation after 
changes has been made to the variable values in the 
Capital Cost view.

Open Page Tab in 
Separate Window icon

Allows you to open the active tab as a separate view.

 Figure 10.2

Open Page Tab in 
Separate Window icon

The TAC value is based on 
the interest rate, plant life, 
income tax factor, capital cost, 
and operating cost.
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The following table lists and describes the objects available in the 
Common tab:

10.1.2 Column Tab
The Column tab allows you to manipulate variables used to calculate 
the size, purchase cost, and installation cost of the column. 

The variables are grouped into five pages: Sizing, Vessel Cost, Tray Cost, 
Misc. Cost, and Installation.

Object Description

Interest Rate 
field

Allows you to enter the value of the interest rate for the current year. 
The program’s default value is 8%.

Plant Life field Allows you to enter the number of years the plant will be operational. 
The program’s default value is 8 years.

Income Tax 
Factor field

Allows you to enter the value of the income tax factor used in 
economic calculation.

Base Year field Allows you to enter the Marshall and Swift Index value for the base 
year. The program’s default value is 599.0 from year 1979.

Current Year 
field

Allows you to enter the Marshall and Swift Index value for the current 
year. The program’s default value is1060 from year 2001.

The program’s default values are based on a carbon steel construction 
material for a temperature range of 20°C-80°C.
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Sizing Page
The Sizing page allows you to manipulate variables used to calculate the 
diameter of the tray, size of the column, and the wall thickness of the 
column.

The following table lists and describes the objects available in the Sizing 
page:

 Figure 10.3

Object Description

Flooding Factor cell Allows you to specify the flooding factor for the trays. The 
program’s default value is 0.70.

DownComer area 
Fraction cell

Allows you to specify the ratio of downcomer area to the tray 
area. The program’s default value is 0.12.

Vapour disengaging 
space cell

Allows you to specify the depth of the vapour disengaging 
space. The program’s default value is1.00 m.

Tray Efficiency cell Allows you to specify the overall tray efficiency for all the trays 
in the column. The program’s default value is 1.00.

Tray Spacing drop-
down list

Allows you to select the tray spacing of the column. The 
program’s default selection is 18 in.

Allowable Stress 
cell

Allows you to specify the maximum allowable stress of the 
construction material for the column. The program’s default 
value is 9.5 x 104kPa.

MOC Density cell Allows you to specify the construction material density for the 
column. The program’s default value is 7860 kg/m3.

Corrosion 
Allowance cell

Allows you to specify the depth to which the column wall will 
corrode during the entire service life of the column. The 
program’s default value is 0.006 m.

Flooding factor is the ratio of 
design vapour velocity to the 
flooding velocity in the 
column.

The flooding factor is used to 
estimate the column diameter.

The program assumes carbon 
steel as construction material 
for a temperature range of 
20°C to 80°C.

The corrosion is assumed to 
occur at the inside of the 
column/vessel wall.
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Vessel Cost Page
The Vessel Cost page allows you to manipulate the variables used to 
calculate the purchase cost of the column vessel.

The following table lists and describes the objects available in the Vessel 
Cost page:

Welding Efficiency 
cell

Allows you to specify the efficiency of the joints welded 
together in the column. The program’s default value is 0.80.

The following four factors are used to account for the seismic effect of the wind load.

Air Density cell Allows you to specify the density of the medium/air surrounding 
the column. The program’s default value is 1.20 kg/m3.

Wind Velocity cell Allows you to specify the maximum wind velocity blowing on to 
the column. The program’s default value is 63 m/s.

Ladder Space cell Allows you to specify the space between the ladder and the 
column’s outer wall. The program’s default value is 0.43 m.

Pressure Safety 
Margin cell

Allows you to specify the safety margin factor for the pressure 
in the column. The program’s default value is 1.20.

 Figure 10.4

Object Description

Lower Limit for 
Weight cell

Allows you to specify the lowest possible weight value for the vessel.

Upper Limit for 
Weight cell

Allows you to specify the highest possible weight value for the 
vessel.

Object Description

The vessel cost is a function 
of the weight, height, and 
diameter of the column and 
the coefficient values. 

This appears in the equation 
in the Vessel Cost group.
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Tray Cost Page
The Tray Cost page allows you to manipulate the variables used to 
calculate the purchase cost of the column trays.

The following table lists and describes the objects available in the Tray 
Cost page:

Coeff A cell Allows you to specify the coefficient value used to calculate the cost 
of the vessel.

Coeff B cell Allows you to specify the coefficient value used to calculate the cost 
of the vessel.

Coeff C cell Allows you to specify the coefficient value used to calculate the cost 
of the vessel.

Coeff D cell Allows you to specify the coefficient value used to calculate the cost 
of the vessel.

 Figure 10.5

Object Description

Lower Limit for 
Diameter cell

Allows you to specify the lowest possible diameter value for the tray.

Upper Limit for 
Diameter cell

Allows you to specify the highest possible diameter value for the tray.

Coeff A cell Allows you to specify the coefficient value used to calculate the cost 
of the tray.

Coeff B cell Allows you to specify the coefficient value used to calculate the cost 
of the tray.

Object Description

The default values in the 
coefficient cells are for 
calculations in SI units.

The tray cost is a function of 
the diameter of the column, 
the number of trays in the 
column, and the coefficient 
values. 

This appears in the equation 
in the Tray/Packing Cost 
group.

The default values in the 
coefficient cells are for 
calculations in SI units.
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Misc. Cost Page
The Misc. Cost page allows you to manipulate the variables used to 
calculate the purchase cost of the ladder and platform for the column.

The following table lists and describes the objects available in the Misc. 
Cost page:

Coeff C cell Allows you to specify the coefficient value used to calculate the cost 
of the tray.

Coeff D cell Allows you to specify the coefficient value used to calculate the cost 
of the tray.

 Figure 10.6

Object Description

Lower Limit for 
Height cell

Allows you to specify the lowest possible height value for the 
tangent-to-tangent length.

Upper Limit for 
Height cell

Allows you to specify the highest possible height value for the 
tangent-to-tangent length.

Lower Limit for 
Diameter cell

Allows you to specify the lowest possible diameter value for the 
vessel.

Upper Limit for 
Diameter cell

Allows you to specify the highest possible diameter value for the 
vessel.

Coeff A cell Allows you to specify the coefficient value used to calculate the cost 
of the ladder and platform.

Object Description

The miscellaneous cost is a 
function of the diameter and 
height of the column, and the 
coefficient values. 

This appears in the equation 
in the Platform and Ladder 
Cost group.

The default values in the 
coefficient cells are for 
calculations in SI units.
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Installation Page
The Installation page allows you to manipulate the variables used to 
calculate the installation cost of the column.

The following table lists and describes the objects available in the 
Installation page:

Coeff B cell Allows you to specify the coefficient value used to calculate the cost 
of the ladder and platform.

Coeff C cell Allows you to specify the coefficient value used to calculate the cost 
of the ladder and platform.

 Figure 10.7

Object Description

Lower Limit for 
Purchase Cost cell

Allows you to specify the lowest possible purchase cost of the 
column.

Upper Limit for 
Height cell

Allows you to specify the highest possible purchase cost of the 
column.

Coeff A cell Allows you to specify the coefficient value used to calculate the 
installation cost for the column.

Coeff B cell Allows you to specify the coefficient value used to calculate the 
installation cost for the column.

Coeff C cell Allows you to specify the coefficient value used to calculate the 
installation cost for the column.

Object Description

The installation cost is a 
function of the column 
purchase cost and the 
coefficient values. 

This appears in the equation 
in the Column Installation 
Cost group.

The default values in the 
coefficient cells are for 
calculations in SI units.
                                                                                                                                                                   10-9



10-10 Capital Cost View
10.1.3 Heat Exchanger Tab
The Heat Exchanger tab allows you to manipulate the variables used to 
calculate the design pressure cost factor, design type cost factor, base 
cost of a heat exchanger, and installation cost of the heat exchanger. The 
options are grouped into three pages: Sizing, Costing, and Installation.

Sizing Page
The Sizing page allows you to manipulate three sets of coefficients used 
for calculating the design pressure cost factor (Fp) for three different 
pressure ranges. 

Coeff D cell Allows you to specify the coefficient value used to calculate the 
installation cost for the column.

Coeff E cell Allows you to specify the coefficient value used to calculate the 
installation cost for the column.

 Figure 10.8

Object Description

The program’s default values 
are based on a carbon steel 
construction material and a 
temperature range of 20°C-
80°C.

The design pressure cost 
factor is a function of the 
exchanger area and the 
coefficient values. 

This appears in the equation 
below the F P Factor tables.
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The following table lists and describes the objects available on the Sizing 
page:

Costing Page
The Costing page allows you to manipulate the variables used to 
calculate the design type cost factor and base cost of the heat exchanger. 

The following table lists and describes the objects available on the 
Costing page:

Object Description

Pressure Lower 
Limit cell

Allows you to specify the lowest possible pressure value.

Pressure Upper 
Limit cell

Allows you to specify the highest possible pressure value.

Coeff A cell Allows you to specify the coefficient value used to calculate the 
design pressure factor.

Coeff B cell Allows you to specify the coefficient value used to calculate the 
design pressure factor.

 Figure 10.9

Object Description

Lower Limit for 
Area cell

Allows you to specify the lowest value of the required heat transfer 
area for the heat exchanger.

Upper Limit for 
Area cell

Allows you to specify the highest possible value of the heat transfer 
area for the heat exchanger.

The default values in the 
coefficient cells are for 
calculations in SI units.

The base cost is a function of 
the exchanger area and the 
coefficient values. 

The design type cost factor is 
a function of the exchanger 
area and the coefficient 
values.

These appear in the 
equations in the Area Cost 
group.
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Installation Page
The Installation page allows you to manipulate the variables used to 
calculate the installation cost of the heat exchanger.

The following table lists and describes the objects available in the 
Installation page:

Coeff A cell Allows you to specify the coefficient value used to calculate the base 
cost for the heat exchanger.

Coeff B cell Allows you to specify the coefficient value used to calculate the base 
cost for the heat exchanger.

Coeff C cell Allows you to specify the coefficient value used to calculate the base 
cost for the heat exchanger.

Coeff D cell Allows you to specify the coefficient value used to calculate the 
design type cost factor for the heat exchanger.

Coeff E cell Allows you to specify the coefficient value used to calculate the 
design type cost factor for the heat exchanger.

 Figure 10.10

Object Description

Lower Limit for 
Purchase Cost cell

Allows you to specify the lowest possible purchase cost of the 
heat exchanger.

Upper Limit for 
Height cell

Allows you to specify the highest possible purchase cost of the 
heat exchanger.

Coeff A cell Allows you to specify the coefficient value used to calculate the 
installation cost for the heat exchanger.

Object Description

The default values in the 
coefficient cells are for 
calculations in SI units.

The installation cost is a 
function of the exchanger 
purchase cost and the 
coefficient values. 

This appears in the equation 
in the Heat Exchanger 
Installation Cost group.

The default values in the 
coefficient cells are for 
calculations done in SI unit.
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10.1.4 Notes Tab
The Notes tab allows you to do the following:

• Change the name of the Capital Cost view by entering a new name 
in the Name field.

• Enter information about the capital cost for the active operation in 
the Notes text editor.

Coeff B cell Allows you to specify the coefficient value used to calculate the 
installation cost for the heat exchanger.

Coeff C cell Allows you to specify the coefficient value used to calculate the 
installation cost for the heat exchanger.

Coeff D cell Allows you to specify the coefficient value used to calculate the 
installation cost for the heat exchanger.

Coeff E cell Allows you to specify the coefficient value used to calculate the 
installation cost for the heat exchanger.

Object Description
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10.2 Utility Database View
The Utility Database view allows you to manipulate existing utilities 
and/or add a new utility to use for cooling or heating a stream/mixture. 

To access the Utility Database view:

1. Open an operation view from the following list of operations:
• HI Case
• HI Project
• Complex Column
• Simple Column
• Three Product System
• Column Sequencing
• Azeotropic Column Sequencing

2. Click the Options tab or page.

The default location and name for the Utility Database file can be set in 
the Session Preferences view. Refer to Section 5.4 - Preferences for 
more information.

 Figure 10.11

When accessing the Utility 
Database view from the HI 
Case or HI Project operation, 
you will see an extra button 
called Select Utility beside the 
Save Default Utilities to File 
icon
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3. Click the Utility Database button. 
The Utility Database view will appear. 

The following table lists and describes the objects available on the 
Utility Database view:

Object Icon Description

Open Saved Default 
Utilities File icon

Allows you to open a utility database file. The file can 
be the program’s default database file or a user 
defined utility database file. 

Save Default 
Utilities to File icon

Allows you to save the current settings in the Utility 
Database view as a file.

Select Utility button Allows you to add the selected utility to the heat 
exchanger network.

Name column Allows you to specify or edit the name of the utility.

Heating or Cooling 
icon

Displays an icon to indicate whether the utility is 
used for heating or cooling.

• HOT. A hot utility stream is cooled down in the 
heat exchange network. The inlet temperature 
of a hot process stream is higher than the 
outlet temperature.

• COLD. A cold utility stream is heated up in the 
heat exchange network. The inlet temperature 
of a cold process stream is lower than the 
outlet temperature.

Inlet T column Allows you to manipulate the temperature of the 
utility entering the heat exchanger.

Outlet T column Allows you to manipulate the temperature of the 
utility exiting the heat exchanger.

HTC column Allows you to manipulate the heat transfer coefficient 
of the utility.

Cost Index column Allows you to manipulate the cost per energy/duty of 
the utility.

ARH column Displays the calculated Application Range High 
temperature value.

ARL column Displays the calculated Application Range Low 
temperature value.

DTmin column Allows you to specify or manipulate the minimum 
temperature difference of the utility.

Hold checkbox Allows you to toggle between calculating or not 
calculating the operating cost. 

The Select Utility button is 
only available when accessing 
the Utility Database view from 
the HI Case or HI Project 
operation.

When the Hold checkbox is 
checked, the program will hold 
on to/hide the information in 
the Utility Database view 
during calculation. When the 
checkbox is unchecked, the 
program will calculate the 
operating cost using the 
current information in the 
Utility Database view.
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10.2.1 Adding a New Utility
To add a new utility type to the database:

1. Open the Utility Database view by clicking the Utility Database 
button.

2. Click on the cell containing **New** in the Name column.

3. Enter the name of the new utility.

4. Click in the Inlet T cell and enter the temperature of the utility going 
into the heat exchanger.

5. Click in the Outlet T cell and enter the temperature of the utility 
exiting the heat exchanger.
An icon to indicating whether the utility is used for heating or 
cooling will appear in the icon cell automatically.

6. Click in the HTC cell and enter the value for the heat transfer 
coefficient of the utility.

7. Click in the Cost Index cell and enter the value for the cost/duty of 
the utility.

8. Click in the DTmin cell and enter the value for the minimum 
temperature difference of the utility.

10.2.2 Deleting a Utility
To delete a utility:

1. Ensure the current operation is not using the utility you want to 
delete.

2. Open the Utility Database view by clicking the Utility Database 
button.

3. in the Name column, click on the name of the utility you want to 
delete.

4. Press DELETE.

The program will not prompt 
you to confirm deletion of a 
utility, so be very careful when 
deleting a utility.
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10.2.3 Saving the Utility Database
The program allows you to save a utility database as a (*.hud) file.

To save the current utility database:

1. Open the Utility Database view by clicking the Utility Database 
button.

2. Modify the utility information to suit your simulation case.

3. Click the Save Default Utilities to File icon.

The Save Heat Integration Defaults view appears.

4. Use the Save in drop-down list to select a location for the new utility 
file.

5. In the File name field, enter the name of the file.

6. Select the location for the file using the Save in drop-down list.

7. Click the Save button to save the utility database file.

 Figure 10.12

Save Default Utilities to File 
icon
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10.2.4 Recalling a Utility Database
To recall a saved utility database:

1. Open the Utility Database view by clicking the Utility Database 
button.

2. Click the Open Saved Default Utilities File icon.
The Open Heat Integration Defaults view appears.

3. Find and select the *.hud file you want using the Look in drop-down 
list.

4. Click the Open button.
The Utility Database view reappears displaying the selected utility 
database information.

 Figure 10.13
Open Saved Default Utilities 
File icon
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